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1. 简介
本章包含使用 MPLAB® PICkit™ 4 在线调试器前需要了解的一般信息。

1.1 文档编排
本文档介绍了如何使用 MPLAB PICkit 4 在线调试器作为开发工具在目标板上仿真和调试固件，以及如何对器件编程。

本文档的内容编排如下：

• 2.  关于调试器 ——简要介绍了 MPLAB PICkit 4 在线调试器及其如何助您开发应用。

• 3.  工作原理 ——MPLAB PICkit 4 在线调试器工作原理。介绍了配置选项。

• 4.  调试器使用 ——介绍了选择 MPLAB PICkit 4 在线调试器作为调试工具时，MPLAB X IDE 中提供的基本调试

功能。其中包括断点和跑表调试功能。

• 6.  疑难解答 ——调试器运行出现问题时首先应该尝试的操作。

• 7.  常见问题解答 ——常见问题列表，有利于故障诊断。

• 8.  错误消息 ——错误消息和建议解决方案的列表。

• 10.  调试器功能汇总 ——选择 MPLAB PICkit 4 在线调试器作为调试或编程工具时，MPLAB X IDE 中提供的调试

器功能汇总。

• 11.  硬件规范 ——调试器系统的硬件和电气规范。

• 版本历史——文档变更及变更时间汇总。

1.2 本指南使用的约定
本手册采用以下文档约定：

表 1-1. 文档约定

说明 表示 示例

Arial 字体：

斜体字 参考书目 MPLAB® IDE User's Guide

需强调的文字 ...仅有的编译器...

首字母大写 窗口 Output 窗口

对话框 Settings 对话框

菜单选择 选择 Enable Programmer

引用 窗口或对话框中的字段名 “Save project before build”

带右尖括号有下划线的斜体文字 菜单路径 File>Save

粗体字 对话框按钮 单击 OK

选项卡 单击 Power 选项卡

N'Rnnnn verilog 格式的数字，其中 N 为总位数，

R 为基数，n 为其中一位。

4'b0010，2'hF1

尖括号< >括起的文字 键盘上的按键 按下<Enter>，<F1>

Courier New 字体：
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...........（续）

说明 表示 示例

常规 Courier New 源代码示例 #define START

文件名 autoexec.bat

文件路径 c:\mcc18\h

关键字 _asm，_endasm，static

命令行选项 -Opa+，-Opa-

二进制位值 0和 1

常量 0xFF，‘A’

斜体 Courier New 可变参数 file.o，其中 file可以是任何有效的

文件名

方括号[ ] 可选参数 mcc18 [options] file [options]

花括号和竖线：{ | } 选择互斥参数；“或”选择 errorlevel {0|1}

省略号... 代替重复文字 var_name [, var_name...]

表示由用户提供的代码 void main (void)
{ ...
}

1.3 推荐读物
本用户指南介绍了如何使用 MPLAB PICkit 4 在线调试器。下面列出了其他有用的文档。以下 Microchip 文档均已提

供，并建议读者作为补充参考资料。

多工具设计忠告（DS51764C_CN）

请先阅读本文档！本文档包含有关在使用 MPLAB PICkit 4 在线调试器进行目标设计时应考虑的操作问题的重要信息。

MPLAB X IDE 在线帮助

这是在使用任何 Microchip 硬件工具时的必备文档。

这是 MPLAB X IDE 的全面帮助文件。它包括嵌入式系统的概述、安装要求、教程以及创建新项目、设置编译属性、调

试代码、设置配置位、设置断点以及编程器件等方面的详细信息。此帮助文件通常比可以从 www.microchip.com/
mplabx/免费下载的用户指南（DS50002027）的 PDF 内容更新。

MPLAB PICkit 4 在线调试器的发行说明

有关使用 MPLAB PICkit 4 在线调试器的最新信息，请阅读 MPLAB X IDE Start Page（起始页）上“Release Notes
and Support Documentation”（发行说明和支持文档）下的说明。发行说明包含本用户指南中可能未提供的更新信息

和已知问题。

MPLAB® PICkit™ 4 在线调试器快速入门指南宣传页（DS50002721B_CN）

该宣传页介绍了如何使用标准通信和目标板为 MPLAB PICkit 4 在线调试器连接硬件和安装软件。
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2. 关于调试器
本章提供了 MPLAB® PICkit™ 4 在线调试器系统的概述。

2.1 MPLAB PICkit 4 在线调试器说明

MPLAB PICkit 4 在线调试器（PG164140）允许利用 MPLAB X 集成开发环境（Integrated Development
Environment，IDE）功能强大的图形用户界面对 Microchip PIC®、dsPIC®、AVR®、SAM 和 CEC（基于 Arm®

Cortex®-M7）单片机快速、轻松地进行调试和编程。

MPLAB PICkit 4 通过高速 2.0 USB 接口连接到设计工程师的计算机，并可通过 Microchip 8 引脚单列直插式（Single
In-Line，SIL）调试连接器连接到目标板。连接器使用两个器件 I/O 引脚和复位线来实现在线调试和在线串行编程（In-
Circuit Serial Programming™，ICSP™）。附加 microSDHC 卡插槽和通过目标板自供电的能力意味着您可以随身“携

带”代码并脱机编程。

MPLAB PICkit 4 的编程速度比其前代产品（PICkit 3）更快，可以支持 PIC、dsPIC、AVR、SAM 和 CEC MCU 器

件。除了更宽的目标电压外，MPLAB PICkit 4 还支持高级接口，如 4 线 JTAG、串行线调试（Serial Wire Debug，
SWD）和流数据网关 1，同时向后兼容使用 2 线 JTAG 和 ICSP 的演示板和目标系统。由于添加了 microSDHC 卡插槽

用于存放项目代码以及可通过目标板供电，MPLAB PICkit 4 还具有独特的脱机编程（Programmer-To-Go，PTG）功

能。

由于该调试器系统使用带有内置仿真电路的器件（而非特殊调试器芯片），因此代码的执行与实际器件相似。通过该

调试器系统可以交互方式访问给定器件的所有可用功能，且可通过 MPLAB X IDE 界面设置和修改这些功能。

MPLAB PICkit 4 在线调试器兼容以下任意平台：

• Microsoft Windows® 7 或更高版本

• Linux®

• macOS®

MPLAB PICkit 4 在线调试器专为调试嵌入式处理器而开发，具有丰富的调试功能，嵌入式处理器在以下方面与传统系

统处理器有所不同：

• 处理器以最大速度运行。

• 能够集成 I/O 端口数据输入。

• 高级主机通信接口（Windows、macOS 和 Linux）。

• 高级通信介质和协议。

• 编程时间更短。

除了调试器功能外，MPLAB PICkit 4 在线调试器系统也可用作器件生产编程器。

2.2 MPLAB PICkit 4 在线调试器的优势

MPLAB PICkit 4 在线调试器系统具有以下优势：

特性/功能：

• 通过高速 USB 2.0（480 Mbps）线缆连接到计算机。

• 8 引脚 SIL 编程连接器，可选择使用各种接口。

• 使用 MPLAB X IDE 或 MPLAB IPE 编程器件。

• 支持多个硬件和软件断点、跑表以及源代码文件调试。

• 在您自己的硬件上实时调试应用程序。

• 基于内部事件设置断点。

• 监视内部文件寄存器。

1 将来通过 MPLAB X IDE 对产品进行更新提供此功能。
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• 全速调试。

• 配置引脚驱动器。

• 可通过 MPLAB X IDE 固件下载进行现场升级。

• 通过安装最新版本的 MPLAB X IDE（可从 www.microchip.com/mplabx/免费下载）添加新的器件支持和功能。

• 通过指示灯带指示调试器状态。

• 可在 0-70°C 的温度范围内工作。

性能/速度：

• 容量更大、速度更快的存储器。

• 实时操作系统（Real-Time Operating System，RTOS）。

• 更换器件时不会发生固件下载延迟。

• 以 300 MHz 频率运行的 32 位 MCU。

安全性：

• 当目标板需要外部电源时，从调试器接收反馈。

• 对于低压编程模式，支持的目标电源电压为 1.2V 到 5.0V；对于高压编程模式，支持的目标电源电压为 2.8V 到

5.0V。
• 使用可选的 9V DC 电源实现最高 1A 的安全供电。

• 在探针驱动器中添加保护电路，以便免受来自目标板的电源浪涌的危害。

• VDD 和 VPP 电压监视器用于过压保护/所有线路均具备过流保护。

• 可设置编程/调试引脚的电阻的值的范围和方向（上拉、下拉或不存在）。

• 可控编程速度提供了灵活性，能够克服目标板设计问题。

• 符合 CE 和 RoHS 标准——符合行业标准。

2.3 MPLAB PICkit 4 在线调试器组件
MPLAB PICkit 4 在线调试器系统的组件包括：

• 长方形的 MPLAB PICkit 4 主机，采用顶部为拉丝金属的耐用黑色塑料外壳，带有指示灯带和按钮区域。

• Micro-B USB 连接器。

• MicroSD 卡插槽。

• 紧急恢复按钮。

• 挂绳连接器。

• Micro-B USB 线缆，用于提供调试器与计算机之间的通信以及向调试器供电。

图 2-1. 基本调试器系统

其他硬件和附件可以从 Microchip 直销网站（www.microchipdirect.com）单独订购。

• 调试器适配器板（部件编号 AC002015）——一款支持 JTAG、SWD 和 ICSP 协议的连接板，适用于使用

MPLAB PICkit 4 调试传统 AVR 单片机（www.microchipdirect.com/product/search/all/AC102015）。
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2.4 MPLAB® PICkit™ 4 框图
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3. 工作原理
本章简要概述了 MPLAB PICkit 4 在线调试器系统的工作原理。旨在提供足够的信息，帮助用户设计与调试器兼容的目

标板，以进行调试和编程操作。本章还讨论了在线调试和编程的基本原理，以便用户能够快速地解决遇到的问题。

3.1 调试器与目标板之间的通信

重要： 在连接 MPLAB PICkit 4 在线调试器之前，必须先安装 MPLAB X IDE 软件。

调试器通过 USB 线缆连接到计算机，以进行通信和为调试器供电。

调试器连接到目标应用以进行通信和数据收集，也可选择通过目标应用为调试器供电。

以下小节介绍了调试器系统配置。

 DS50002596B-page 18  2017 Microchip Technology Inc.

CAUTION

Communication Failure.
Do not connect the hardware before installing the software and 
USB drivers.

CAUTION

Debugger or Target Damage.
Do not change hardware connections while the debugger or target 
is powered.

注： 为确保 MPLAB PICkit 4 在线调试器正常工作，必须使用提供的线缆。使用其他供应商提供的线缆可能会导致通

信错误。

3.1.1 标准 ICSP 器件通信

可将调试器系统配置为使用标准 ICSP 通信连接来执行编程和调试功能。

确保将调试器上的引脚 1 与目标板上的引脚 1 对齐。编程连接器可插入目标板上的配套连接器，即目标器件在目标板

上的位置。
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图 3-1. 标准调试器系统——具有片上 ICE 电路的器件

有关标准通信的更多信息，请参见标准通信。

3.2 目标板通信连接

重要： 有关更多信息和图，请参见所用器件的数据手册以及特定接口的应用笔记。

3.2.1 标准通信目标板连接

使用单列直插式连接器

在 MPLAB PICkit 4 在线调试器和目标板连接器之间使用单列直插式连接器（见图 3-1 和标准通信）。

使用适配器

使用 AC164110 适配器，通过模块化接口（6 芯）线缆将 MPLAB PICkit 4 在线调试器连接到目标器件。连接器的引脚

编号显示在目标 PCB 的底部，如下图所示。

图 3-2. 目标板上的标准 RJ-11 连接

1

2

3

4

5

6

Target
Connector

Target

Bottom Side
PC BoardVPP/MCLR

Vss

PGC
VDD

PGD
Reserved
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3.2.2 目标板连接电路

下图显示了 MPLAB PICkit 4 在线调试器与目标板上连接器的互连。该图还显示了从连接器到目标 PCB 上器件的连

线。建议在 VPP/MCLR 线和 VDD 之间连接一个上拉电阻（通常约为 10-50 kΩ），以便将该线选通为低电平以复位器

件。

图 3-3. 与目标电路的标准连接

3.2.3 目标板供电

在下面的说明中，将只谈到与关键调试器操作相关的三根有效线：引脚 1（VPP/MCLR）、引脚 5（PGC）和引脚 4
（PGD）。图 3-3 中显示了引脚 2（VDD）和引脚 3（VSS）是出于完整性考虑。MPLAB PICkit 4 提供两种配置为目标

器件供电：内部调试器和外部目标电源。

推荐使用来自目标应用的外部电源（见下图）。在该配置中，调试器检测目标 VDD 以进行电压转换来实现目标低电压

操作。如果调试器在其 VDD 线（接口连接器的引脚 2）上未检测到电压，则它将无法工作。

图 3-4. 通过外部电源为目标板供电

3.2.4 调试器供电

如果通过连接外部供电集线器的调试器为目标板供电（如下所示），则目标板可用的电流限制为 50 mA。
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图 3-5. 通过自供电集线器为目标板供电

并非所有的器件都有 AVDD 和 AVSS 线，但是如果目标器件上有这两根线，为了调试器能够正常工作，必须将它们连接

到适当的电平。它们不能处于悬空状态。

此外，应将具有 VCAP 线的器件（例如 PIC18FXXJ）连接到适当的电容或电平。

注： 相互连接非常简单。对于遇到的任何问题，通常都是由这些关键线上干扰 MPLAB PICkit 4 在线调试器操作的其

他连接或元件引起的，如下节所述。

3.2.5 阻止调试器正常工作的电路
下图给出了调试器的三根有效线上会阻止 MPLAB PICkit 4 在线调试器系统正常工作的一些元件。

图 3-6. 不正确的电路元件

确切地说，必须遵循以下准则：

• 请勿在 PGC/PGD 上使用上拉——它们会破坏电压，因为这些线在调试器中有可编程下拉电阻。

• 请勿在 PGC/PGD 上使用电容——它们将阻止数据线和时钟线在编程和调试通信期间快速变化并且会延长编程时

间。

• 请勿在 MCLR 上使用电容——它们将阻止 VPP 快速变化。通常一个简单的上拉电阻就已足够。

• 请勿在 PGC/PGD 上使用二极管——它们将阻止调试器和目标器件之间进行双向通信。

3.3 调试
使用 MPLAB PICkit 4 在线调试器系统作为调试器有两个步骤。第一步要求将应用程序编程到目标器件中（通常使用

MPLAB PICkit 4 本身）。第二步是使用目标闪存器件的内部在线调试硬件来运行和测试应用程序。这两步与 MPLAB
X IDE 操作直接相关：
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1. 将代码烧写到目标器件并激活具体的调试功能。

2. 使用断点等功能调试代码。

注： 有关更多信息，请参见 MPLAB X IDE 在线帮助。

如果目标器件不能被正确编程，MPLAB PICkit 4 在线调试器将无法进行调试。

下面给出了 MPLAB PICkit 4 在线调试器的部分内部接口电路的简化图。

图 3-7. 正确的编程连接

编程时，目标器件不需要时钟，但必须为其提供电源。编程时，调试器在 VPP/MCLR 上施加编程电压，通过 PGC 发

送时钟脉冲，通过 PGD 发送串行数据。要校验器件是否已被正确编程，可以向 PGC 发送时钟，并通过 PGD 读回数

据。此操作可确认调试器与器件之间是否正确通信。

3.4 调试要求

要使用 MPLAB PICkit 4 在线调试器系统进行调试（设置断点和查看寄存器等），以下关键因素必须正确：

• 必须将调试器连接到计算机。它必须通过 USB 线缆由计算机供电，并且必须通过 Micro-B USB 线缆与 MPLAB X
IDE 软件通信。请参见标题为“Getting Started with MPLAB X IDE”的 MPLAB X IDE 帮助文件，并在

“Tutorial”（教程）中导航到“Running and Debugging Code”（运行和调试代码）部分。

• 调试器必须通过模块化接口线缆（或等效线缆）连接到目标器件的 VPP、PGC 和 PGD 引脚（如 3.3.  调试中的图

所示）。

• 目标器件必须通电且具有正常运行的振荡器。如果目标器件因任何原因无法运行，MPLAB PICkit 4 在线调试器将

无法进行调试。

• 必须正确编程目标器件的配置字。这些配置字使用 MPLAB X IDE 来设置。

– 振荡器配置位应对应于 RC 和 XT 等，具体取决于目标设计。

– 对于某些器件，看门狗定时器默认使能，需要禁止。

– 不要使能目标器件的代码保护功能。

– 不要使能目标器件的表读保护功能。

– 对于具有多个 PGC/PGD 引脚对的某些器件，需要在器件的配置字设置中选择正确的引脚对。这一点仅针对

调试，因为编程可通过任何 PGC/PGD 引脚对工作。

满足了以上条件后，即可接着进行下列操作：

• 3.4.1.  进入调试模式的操作序列

• 3.4.2.  调试详细信息

3.4.1 进入调试模式的操作序列

假定满足 3.4.  调试要求，将 MPLAB PICkit 4 在线调试器设置为 MPLAB X IDE 中的当前工具。转到 File > Project
Properties（文件 > 项目属性），打开对话框，然后在“Hardware Tool”（硬件工具）下单击 PICkit 4。现在可以执

行以下操作。
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• 选择 Debug > Debug Main Project（调试 > 调试主项目）时，应用程序代码将通过 ICSP 协议编程到器件的存储

器中，如本章开头所述。

• 一个小的“调试执行程序”将加载到目标器件的程序存储器的高地址区域中。由于调试执行程序必须驻留在程序
存储器中，因此应用程序不能使用此保留的空间。有些器件为调试执行程序提供了专门的存储区。有关详细信

息，请参见器件数据手册。

• 目标器件中的特殊“在线调试”寄存器通过 MPLAB X IDE 使能。这些寄存器允许调试器激活调试执行程序。有

关器件保留资源的更多信息，请参见 3.6.  调试器使用的资源。

• 目标器件在调试模式下运行。

3.4.2 调试详细信息

下图显示了准备好开始调试的 MPLAB PICkit 4 在线调试器系统。

图 3-8. 准备好开始调试的 MPLAB® PICkit™ 4 在线调试器

为判断应用程序能否正确运行，通常可在程序代码中预先设置断点。当通过 MPLAB X IDE 的用户界面设置断点时，断

点的地址存储在目标器件的特殊内部调试寄存器中。PGC 和 PGD 上的命令直接传送到这些寄存器来设置断点地址。

接下来，通常在 MPLAB X IDE 中选择 Debug > Debug Main Project 功能。然后，调试器通知调试执行程序运行。目

标器件将从复位向量开始执行，直到程序计数器到达先前存储在内部调试寄存器中的断点地址。

执行断点地址处的指令后，目标器件的在线调试机制会“启动”，并将器件的程序计数器传递给调试执行程序（类似

于中断），用户的应用程序将暂停执行。调试器通过 PGC 和 PGD 与调试执行程序通信，获取断点状态信息，并将这

些信息发送回 MPLAB X IDE。随后，MPLAB X IDE 向调试器发送一系列查询，以获取关于目标器件的信息，例如文

件寄存器内容和 CPU 状态。这些查询由调试执行程序执行。

调试执行程序像程序存储器中的应用程序一样运行。它使用堆栈中的某些地址单元存储临时变量。如果器件没有运
行，无论出于何种原因（没有振荡器、电源连接故障和目标板短路等），调试执行程序都将无法与 MPLAB PICkit 4 在

线调试器通信，并且 MPLAB X IDE 将发出一条错误消息。

设置断点的另一种方法是选择 Debug > Pause（调试 > 暂停）。这会翻转 PGC 和 PGD 线，从而使目标器件的在线调

试机制将程序计数器从程序存储器中的用户代码切换到调试执行程序。同样，目标应用程序暂停，MPLAB X IDE 通过

调试器与调试执行程序的通信来查询目标器件的状态。

3.5 编程
注： 有关编程的信息，请参见 MPLAB X IDE 在线帮助。
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注意： MPLAB PICkit 4 不支持调试头。

在 MPLAB X IDE 中，使用 MPLAB PICkit 4 作为编程器来编程非-ICE/-ICD 器件，即不在调试头板上的器件。将

MPLAB PICkit 4 在线调试器设置为当前工具（单击导航窗口中的 Debug Tool PICkit 4（调试工具 PICkit 4），接着选

择 File > Project Properties，然后在“Hardware Tool”下单击 PICkit 4）以执行这些操作：

• 选择 Run Main Project（运行主项目）图标（见下图）后，应用程序代码将通过 ICSP 协议编程到器件的存储器

中。编程时不需要时钟，可以编程所有的处理器模式，包括代码保护、使能看门狗定时器和表读保护。

图 3-9. Run Main Project 图标

• 对于某些目标器件，可以将一个小的“编程执行程序”加载到程序存储器的高地址区域中。

• 目标器件中的特殊“在线调试”寄存器以及所有调试功能均通过 MPLAB X IDE 禁止。这意味着不能设置断点，

不能查看或更改寄存器内容。

• 目标器件运行在发布模式下。作为编程器，调试器只能通过翻转 MCLR 线来复位和启动目标器件。

MPLAB PICkit 4 在线调试器系统通过 ICSP 编程目标器件。VPP、PGC 和 PGD 线应如前所述连接。编程时不需要时

钟，可以编程所有的处理器模式，包括代码保护、看门狗定时器和表读保护。

3.6 调试器使用的资源
有关器件中调试器所用资源的完整列表，请参见 MPLAB X IDE 中有关 MPLAB PICkit 4 在线调试器的在线帮助文件。

在 MPLAB X IDE 的“Learn & Discover”（学习和发现）页面中，单击 Users Guide & Release Notes（用户指南和

发行说明），然后单击“Reserved Resources for MPLAB PICkit 4”（为 MPLAB PICkit 4 保留的资源）链接。
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4. 调试器使用
本章将讨论如何安装和设置 MPLAB PICkit 4 在线调试器系统。有关将 MPLAB X IDE 与调试器配合使用的说明，请参

见可从 MPLAB X IDE 主菜单栏 Help > Tool Help Contents > MPLAB X IDE Help（帮助>工具帮助内容>MPLAB X IDE
帮助）访问的在线帮助。

4.1 安装和设置
在 MPLAB X IDE 中，有关安装 IDE 并设置调试器以与 IDE 配合使用的详细信息，请参见“Getting Started with
MPLAB X IDE”在线帮助文件。

概述：

1. 安装 MPLAB X IDE。

提示： MPLAB X IDE 在线帮助中提供了教程主题，可从主菜单栏 Help > Tool Help Contents >
MPLAB X IDE Help >Tutorial（帮助>工具帮助内容> MPLAB X IDE 帮助>教程）中访问这些主题。

2. 将 MPLAB PICkit 4 连接到计算机并允许安装默认 USB 驱动程序。有关目标板连接的更多信息，请参见工作原

理。

重要： 调试器只能为目标板提供最大 50 mA 的电流。

3. 选择项目开发要使用的语言工具套件/编译器，并将其安装在计算机上。

4. 启动 MPLAB X IDE 并打开在线帮助（Help > Tool Help Contents > MPLAB X IDE Help），以获取有关创建和

设置新项目以及运行和调试代码的详细说明。

注意事项：

1. 每个调试器都包含一个惟一标识符，首次安装时，无论使用哪个计算机 USB 端口都会由操作系统识别。

2. MPLAB X IDE 在运行（运行或调试运行）时连接至硬件工具。要始终连接到硬件工具，请转至 Tools > Options
（工具>选项）中的 Embedded（已安装工具）按钮，然后在 Generic Settings（通用设置）选项卡中选中

“Maintain active connection to hardware tool”（保持与硬件工具的有效连接）复选框。

3. 配置位只能在 Configuration Bits（配置位）窗口中查看。要在代码中设置配置位，选择 Window > Target
Memory Views（窗口>目标存储器视图），然后从 Memory（存储器）下拉列表中选择“Configuration Bits”，

从 Format（格式）下拉列表中选择“Read/Write”（读/写）使能对设置的访问。

4.2 调试教程
请参见标题为“Getting Started with MPLAB X IDE”的 MPLAB X IDE 帮助文件，并在“Tutorial”中导航到

“Running and Debugging Code”部分。

4.3 调试/编程快速参考
下表给出了将 MPLAB PICkit 4 在线调试器用作调试或编程工具时的快速参考。
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注意： MPLAB PICkit 4 不支持调试头。

表 4-1. 调试与编程操作

项目 调试 编程

所需硬件 计算机和目标应用（Microchip 演示板或您自己设计的电路板）。

调试器、USB 线缆和电源（如果需要）。

带片上调试电路的器件。 器件（带或不带片上调试电路）。

MPLAB X IDE
选择

Project Properties，Hardware Tool 选择 ICD 4。

Debug Main Project 图标 。 Make and Program Device（编译并编程器件）图标 。

编程操作 将应用程序代码烧写到器件中。这可以是程序存储
器的任何范围，具体取决于 Project Properties 对

话框上的选择。此外，还有一个小的调试执行程序

位于程序存储器中，其他调试资源保留。

将应用程序代码烧写到器件中。这可以是程序存储器的任何范
围，具体取决于 Project Properties 对话框上的选择。

可用的调试功能 适用于器件的所有调试功能——断点等 N/A

序列号快速编程
（Serial Quick-
Time
Programming，
SQTP）

N/A 使用 MPLAB IPE 生成 SQTP 文件。

命令行操作 使用 MDB 命令行实用程序，默认路径为：

C:\Program Files (x86)\Microchip\
MPLABX\vx.xx\mplab_platform\bin\mdb.bat

使用 IPECMD，默认路径为：

C:\Program Files (x86)\Microchip\
MPLABX\<vx.xx\mplab_platform\mplab_ipe\ipecmd.exe

脱机编程 N/A 将 MPLAB PICkit 4 中插入的 microSDHC 卡所存储的应用程序

代码编程到器件中。

4.4 调试器限制

有关器件的调试器限制的完整列表，请参见 MPLAB X IDE 中的在线帮助文件（Help > Tool Help Contents > Hardware
Tool Reference Help > Limitations - Emulators and Debuggers（帮助>工具帮助内容>硬件工具参考帮助>限制——仿

真器和调试器）。

4.5 常用调试功能

有关调试功能的详细信息，请参阅在线帮助文件“Getting Started with MPLAB X IDE”的“Running and Debugging
Code”部分。此部分的内容包括：

1. 通过 Debug > Debug Main Project 调试运行项目（编译、编程并运行）。

2. 使用断点。

3. 单步执行代码。

4. 使用 Watches（观察）窗口。

5. 查看存储器、变量和调用堆栈。

6. 使用调用图。

 
调试器使用

© 2019-2022 Microchip Technology Inc.
及其子公司

 用户指南 DS50002751G_CN-第 17 页



4.6 连接目标板
1. 如果尚未连接，请使用 Micro-B USB 线缆将调试器与计算机相连。

2. 使用适当的线缆将调试器连接到目标板。

3. 如果需要，将电源连接到目标板。

图 4-1. 插入通信和 USB 线缆

有关更多详细信息和图，请参见调试器与目标板之间的通信。

4.7 设置目标板
必须为要使用的目标器件类型设置目标板。

4.7.1 使用生产器件

对于生产器件，可以将调试器直接连接到目标板。目标板上的器件必须有内置调试电路，以便 MPLAB PICkit 4 在线调

试器使用它进行调试。

目标板必须有一个连接器，以适合为调试器所选的通信方式。有关连接信息，请参见调试器与目标板之间的通信。

4.7.2 为目标板供电

配置要点：

• 通过 USB 连接，MPLAB PICkit 4 可由计算机供电，但它只能通过 1.2-5V 的 VDD 为小目标板提供有限的电流，最

大 50 mA。
• 理想的方法是由目标板提供 VDD，因为它可以提供更大的电流。这样做的另一个优点是可继承即插即用的目标检

测功能，例如，当 MPLAB X IDE 检测到目标板和器件时，它将在 Output（输出）窗口中通知您。

请使用适当的线缆将 MPLAB PICkit 4 连接到目标板（见 4.6.  连接目标板），如果您尚未执行此操作。然后为目标板

供电。

4.8 设置 MPLAB X IDE
连接好硬件并通电后，可以设置 MPLAB X IDE 以便与 MPLAB PICkit 4 在线调试器配合使用。

在某些器件上，必须在配置位中选择通信通道，例如 PGC1/EMUC1 和 PGD1/EMUD1。确保此处选择的引脚与物理连

接到器件的引脚相同。

有关安装软件并设置调试器以与 MPLAB X IDE 配合使用的详细信息，请参见 MPLAB X IDE 帮助。

4.9 启动和停止调试
注： 有关菜单选项图标的信息，请参见 MPLAB X IDE 在线帮助。

要在 MPLAB X IDE 中调试应用程序，必须创建一个包含源代码的项目，以便按照如下所述编译代码、将代码烧写到器

件中并执行：
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• 选择 Debug > Debug Main Project 或从 Run（运行）工具栏选择 以运行代码。

• 选择 Debug > Pause 或从 Debug（调试）工具栏中选择 以暂停代码。

• 选择 Debug > Continue（调试>继续）或从 Debug 工具栏中选择 以再次运行代码。

• 选择 Debug > Step Into（调试>单步进入）或从 Debug 工具栏中选择 以单步执行代码。注意不要单步进入

Sleep 指令，否则必须执行处理器复位以恢复调试。

• 选择 Debug > Step Over（调试>单步跳过）或从 Debug 工具栏中选择 以单步跳过一行代码。

• 选择 Debug > Finish Debugger Session（调试>完成调试器会话）或从 Debug 工具栏中选择 以结束代码执

行。

• 选择 Debug > Reset（调试>复位）或从 Debug 工具栏中选择 以对代码执行处理器复位。

根据器件的不同，可能有其他复位（如 POR/BOR、 MCLR 和系统复位）。有关更多信息，请参见产品数据手册。

4.10 查看处理器存储器和文件
MPLAB X IDE 提供了多个窗口来查看调试信息和存储器信息，可在 Window（窗口）菜单中进行选择。有关使用这些

窗口的更多信息，请参见 MPLAB X IDE 在线帮助。

• Window > Target Memory Views——查看器件存储器中的数据（数据存储器）和代码（执行存储器）。其他存储

器也可以按器件的定义进行查看，包括外设、配置位、CPU 寄存器、外部 EBI 存储器、外部 SQI 存储器和用户

ID 存储器等。

• Window > Debugging（窗口>调试）——查看调试信息。从变量、观察、调用堆栈、断点和跑表等中进行选择。

要查看源代码，在 Projects（项目）窗口中找到要查看的源代码文件并双击以在 Files（文件）窗口中打开。该窗口中

的代码根据所选处理器和编译工具采用不同颜色标识。要更改颜色标识的样式，在 Tools > Options 的 Fonts & Colors
（字体和颜色）中，选择 Syntax（语法）选项卡。

4.11 断点和跑表
使用断点在代码中的指定行处暂停代码执行。使用跑表和断点对代码执行进行计时。

4.11.1 断点资源

对于 16 位器件，断点、数据捕捉和运行时观察使用相同的资源。因此，可用的断点数实际上是可用的断点和触发的总

数。

对于 32 位器件，断点使用的资源与数据捕捉和运行时观察不同。因此，可用的断点数与可用的触发数无关。

可用和/或已用的硬件和软件断点数在 Dashboard（仪表板）（Window > Dashboard（窗口 > 仪表板））窗口中显

示。有关该功能的更多信息，请参见 MPLAB X IDE 在线帮助文件。并非所有器件都有软件断点。

有关断点操作的限制（包括每个器件硬件断点的常规数目以及硬件断点的断点滑移（skidding）大小），请参见

MPLAB X IDE 的在线帮助文件了解有关调试器限制的信息（Help > Help Contents > Hardware Tool Reference >
Limitations - Emulators and Debuggers（帮助 > 帮助内容 > 硬件工具参考 > 限制——仿真器和调试器））。

4.11.2 硬件或软件断点选择

要选择硬件或软件断点：

1. 在 Projects 窗口中选择项目。然后，选择 File > Project Properties，或右键单击项目并选择 Properties（属

性）。

2. 在 Project Properties 对话框的“Categories”（类别）下，选择 PICkit 4。
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3. 在“Option Categories”（选项类别）下，选择 Debug Options（调试选项）。

4. 选中 Use software breakpoints（使用软件断点）以使用软件断点。取消选中即可使用硬件断点。

提示： 使用软件断点进行调试会影响器件的耐用性。因此，建议不要将以这种方式使用过的器件用作生产

器件。

为帮助您确定使用哪类断点（硬件或软件），下表对每种断点的特性进行了比较。

表 4-2. 硬件断点与软件断点

特性 硬件断点 软件断点

断点数 有限 无限

断点写入到* 内部调试寄存器 闪存程序存储器

断点应用于** 程序存储器/数据存储器 仅程序存储器

设置断点的时间 极短 取决于振荡器速度、编程闪存存储器的
时间以及页大小

断点滑移（skidding） 大多数器件。有关详细信息，请参见在线帮助中的

Limitations（限制）部分。

无

*器件中写入断点信息的位置。

**适用于断点的器件功能类型。这是设置断点的位置。

4.11.3 断点和跑表的使用

断点用于暂停代码的执行。要确定两个断点之间的时间，请使用跑表。

有关如何设置及使用断点和跑表的信息，请参见 MPLAB X IDE 在线帮助。
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5. MPLAB PICkit 4 脱机编程
MPLAB PICkit 4 脱机编程（PTG）功能可将器件存储器映像下载到插入 MPLAB PICkit 4 工具的 microSDHC 卡中，以

便之后编程到特定器件中。该映像包含编程算法信息。MPLAB PICkit 4 编程器设置为脱机编程后，不需要软件和 PC
即可编程器件。可以使用 MPLAB X IDE（见 5.3.1.  使用 MPLAB X IDE 设置 PTG 模式）或 MPLAB IPE（见 5.3.2. 
使用 MPLAB IPE 设置 PTG 模式）将 MPLAB PICkit 4 设置为脱机编程模式。

注：

在脱机编程模式下，不能使用任何调试功能。

图 5-1. MPLAB® PICkit™ 4 在线调试器图

脱机编程的先决条件

• 必须在计算机上安装 MPLAB X IDE 或 MPLAB IPE（v5.25 或更高版本）。

• MicroSDHC 卡——必须将格式化的 FAT32 兼容 microSDHC 卡正确插入 MPLAB PICkit 4 工具中以使用脱机编程

功能。

• 电源——用于将 MPLAB PICkit 4 设置为脱机编程模式以及远程编程器件。有关具体电源要求，请参见以下章节。

5.1 脱机编程的电源要求
连接到计算机时

当需要将 MPLAB PICkit 4 在 MPLAB X IDE 或 MPLAB IPE 应用程序中连接到计算机时，使用随附的 USB 线缆将计算

机与工具顶部的 Micro-B USB 连接器相连。

使用 PTG 编程器件时
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将 MPLAB PICkit 4 连接到远程目标板以使用脱机编程功能对器件进行编程时，目标板至少需要为 MPLAB PICkit 4 提

供 350 mA 的电流。

如果目标板无法提供足够的电流，则必须通过 MPLAB PICkit 4 工具顶部的 Micro-B USB 连接器使用 5V 电源为

MPLAB PICkit 4 供电。可通过如下方法来提供电源：

• 任何可用的 PC USB 端口或 USB 集线器端口（无需 USB 通信；仅用于提供电源）。

• 便携式设备的 USB 主机端口。

• USB 电源适配器或带 USB Micro-B 连接器的充电器，连接到汽车电源插孔或交流电源插座。

• 便携式电池充电器或电源，用于手机或其他带 USB Micro-B 连接器的便携式设备。

• 为 MPLAB PICkit 4 USB Micro-B 连接器提供 5V 稳压电源的定制电池组。

所用 USB 电源应满足以下最低标准：

• 至少能够为 MPLAB PICkit 4 工具提供 350 mA 的电流。

• 提供稳定的 4.5V-5.5V 稳压输出。

注：

1. 大多数自带电池的便携式充电器/电源设备在其内部电池电压变低、输出跌落到 4.5V 以下时，不会提供指示信

息。因此，必须确保设备电池有足够的剩余容量为 MPLAB PICkit 4 提供 4.5V 以上的电源。

2. 在不使用时，任何电池电源都应与 MPLAB PICkit 4 设备断开连接。否则 MPLAB PICkit 4 设备将耗尽电源电

池。

5.2 脱机编程的限制
1. 必须将格式化的 FAT32 兼容 microSDHC 卡正确插入 MPLAB PICkit 4 中以使用脱机编程功能。

图 5-2. 正确插入 MicroSDHC 卡

2. 支持的器件：有关器件支持信息，请参见 MPLAB PICkit 4 发行说明（自述文件）。

3. 在脱机编程模式下，如果目标板正在为 PICkit 4 供电，则它必须能够提供 350 mA 的电流，PICkit 4 工具才能正

常运行。如果目标板不能提供足够的电流，则需通过连接电源、计算机或 USB 移动电源的 PICkit 4 USB 端口直

接为 PICkit 4 供电。有关建议的电源，请参见 5.1.  脱机编程的电源要求。

4. 如果不需要高压（High Voltage，HV）编程，建议在器件支持的情况下使用低压编程（Low Voltage
Programming，LVP）。
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5. 在 HV 编程模式下使用 PTG 时，如果 PICkit 4 将由目标板供电，则需要目标电源并为 NMCLR 串联一个 100Ω
的电阻。或者，遵循 MPLAB PICkit 4 产品网页（www.microchip.com/Developmenttools/ProductDetails/
PG164140）上的 ETN-37 MPLAB PICkit 4 VPP 过冲修改文档中所述的步骤。

6. 目标电压的最大值限制为 5.0V。

5.3 将 PICkit 4 设置为脱机编程模式
在将存储器映像下载到 MPLAB PICkit 4 进行 PTG 操作之前，应针对脱机编程操作设置 PICkit 4 编程器选项。实际

上，强烈建议在下载映像以进行脱机编程之前，首先使用所需选项通过软件编程目标器件进行测试，确保按预期编程

器件。之后可以将 PICkit 4 置于 PTG 模式。有关说明，请参见以下章节。

5.3.1 使用 MPLAB X IDE 设置 PTG 模式

使用 MPLAB X IDE，按照以下步骤将项目文件下载到 MPLAB PICkit 4 中插入的 microSDHC 卡并进入脱机编程模

式。

1. 将格式化的 FAT32 兼容 microSDHC 卡插入 PICkit 4。

2. 确保已正确连接要进行脱机编程的器件：

– 通过 USB 线缆将 PICkit 4 连接到计算机。

– 通过相应的编程接口连接器将 PICkit 4 连接到目标板。

– 目标板由 PICkit 4 或电源供电，具体取决于 Project Properties 中的选择。

3. 在 MPLAB X IDE 中，打开要使用的项目，然后选择 PICkit 4 工具进行编程。

4. 右键单击您的项目名称，打开 Project Properties 对话框。然后单击 Categories 下的 PICkit 4，随即将在屏幕右

侧显示 Options for PICkit 4（PICkit 4 的选项）。选择 Programmer-To-Go（脱机编程）选项类别。
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图 5-3. MPLAB® X IDE Programmer-To-Go 选项

5. 在 Image Name（映像名称）字段中，默认设置为“<your project name>_ptg”，但也可根据需要编辑名称。

这将是 microSDHC 卡上的文件夹名称，其中包含脱机编程的相关文件。

6. 在 Send image to tool（将映像发送到工具）中，复选框默认处于选中状态。选中该复选框后，将创建 PTG 映

像，然后将其发送到所连接的 MPLAB PICkit 4 中插入的 microSDHC 卡。

7. Program Device（编程器件）复选框默认处于选中状态。选中该复选框后，将对连接到 MPLAB PICkit 4 的器件

进行编程。
注： 如果 Send image to tool 和 Program Device 复选框均未选中，请参见 5.3.3.  在没有存储卡的情况下设置

PTG 模式。

8. 请单击 Apply（应用），然后单击 OK（确定）。使用工具栏上的 Make and Program Device Main Project（编

译和编程器件主项目）图标并选择 Programmer-To-Go PICkit3/PICkit4 Main Project（脱机编程 PICkit3/
PICkit4 主项目）。

图 5-4. MPLAB® X IDE——将映像下载到 MicroSDHC 卡

在此过程中，将对器件进行编程，然后在 microSDHC 卡中装入脱机编程操作的相关文件。当过程成功完成时，

Output 窗口将显示状态消息“Programming/Verify complete”（编程/校验完成）。

注： microSDHC 卡上的 PTG 设置与项目中的设置相同（例如，存储器和电源等）。
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PICkit 4 现在处于脱机编程模式。LED 应呈绿色闪烁状态，表示已成功配置了工具的脱机编程模式。

9. 将 PICkit 4 断开连接，现在即可使用脱机编程。

5.3.2 使用 MPLAB IPE 设置 PTG 模式

使用 MPLAB IPE，按照以下步骤将项目文件下载到 MPLAB PICkit 4 中插入的 microSDHC 卡并进入脱机编程模式。

1. 将格式化的 FAT32 兼容 microSDHC 卡插入 PICkit 4。

2. 确保已正确连接要进行脱机编程的器件：

– 通过 USB 线缆将 PICkit 4 连接到计算机。

– 通过相应的编程接口连接器将 PICkit 4 连接到目标板。

– 目标板由 PICkit 4 或电源供电，具体取决于 Project Properties 中的选择。

3. 在 MPLAB IPE 菜单中，依次选择 Settings（设置）和 Advance Mode（高级模式），然后输入登录密码。单

击左侧的 Settings 图标，打开 Special Setting（特殊设置）对话框，并转到 Program-To-Go 设置。

 
MPLAB PICkit 4 脱机编程

© 2019-2022 Microchip Technology Inc.
及其子公司

 用户指南 DS50002751G_CN-第 25 页



图 5-5. MPLAB® IPE Programmer-To-Go 选项

4. 在 Image Name 字段中，默认设置为“<your project name>_ptg”，但也可根据需要编辑名称。这将是

microSDHC 卡上的文件夹名称，其中包含脱机编程的相关文件。

5. 在 Send image to tool 中，复选框默认处于选中状态。选中该复选框后，将创建 PTG 映像，然后将其发送到所

连接的 MPLAB PICkit 4 中插入的 microSDHC 卡。

6. Program Device 复选框默认处于选中状态。选中该复选框后，将对连接到 MPLAB PICkit 4 的器件进行编程。

注： 如果 Send image to tool 和 Program Device 复选框均未选中，请参见 5.3.3.  在没有存储卡的情况下设置

PTG 模式。

7. 单击 Programmer-To-Go 按钮。

在此过程中，将对器件进行编程，然后在 microSDHC 卡的脱机编程目录中装入脱机编程操作的相关文件。当过

程成功完成时，Output 窗口将显示状态消息“Programming/Verify complete”。

注： microSDHC 卡上的 PTG 设置与项目中的设置相同（例如，存储器和电源等）。

PICkit 4 现在处于脱机编程模式。LED 应呈绿色闪烁状态，表示已成功针对脱机编程配置了工具。

8. 将 PICkit 4 断开连接，现在即可使用脱机编程。
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5.3.3 在没有存储卡的情况下设置 PTG 模式

如果您在设置 PTG 模式时不想发送映像或对器件进行编程，则无需在 PICkit 4 中插入 microSDHC 卡也可将其置于

PTG 模式。此方法可将 PICkit 4 置于 PTG 模式，并假定在使用 PTG 对器件进行编程之前，所需的映像已装入将插入

PICkit 4 中的 microSDHC 卡上。

有些情况下您可能希望这样做，例如，用于对器件进行编程的文件压缩为 zip 文件，并发送到不同的设备（可将其解压

缩并下载到 microSDHC 卡，然后将该卡插入已处于 PTG 模式的 PICkit 4 中）。或者，您可能会遇到以下情况：将

PICkit 4 的多个实例置于 PTG 模式下，并使用用于各种器件的 microSDHC 卡对这些器件进行编程。这些情况下，可

能会想要在未安装存储卡的情况下设置 PTG 模式。

请参见 5.3.1.  使用 MPLAB X IDE 设置 PTG 模式或 5.3.2.  使用 MPLAB IPE 设置 PTG 模式中的说明，但不要选中

Send Image to Tool 和 Program Device 复选框。继续按照上述章节提供的说明进行操作，将 PICkit 4 置于 PTG 模

式。

请记住，要使用 PTG，必须将装有所需映像的 microSDHC 卡插入 PICkit 4 中。

5.4 使用脱机编程

当您准备好使用 MPLAB PICkit 4 在 PTG 模式下开始对器件进行编程时，请完成以下步骤：

1. 将已插入 microSDHC 卡的 PICkit 4 工具连接到装有项目中指定器件的目标板。

2. 确保已正确连接要进行脱机编程的器件：

– 通过目标板上相应的编程接口连接器来连接 PICkit 4。确保目标板上的引脚 1 对准 PICkit 4 上的引脚 1 指

示标记。

– 目标板由 PICkit 4 或电源供电，具体取决于 Project Properties 中的选择。

注： 在脱机编程模式下，如果目标板正在为 MPLAB PICkit 4 供电，则它必须能够提供 350 mA 的电流，PICkit
4 工具才能正常运行。

3. 当 PICkit 4 LED 变为绿色闪烁状态时，即可进行脱机编程。如果 microSDHC 卡上没有映像，则 MPLAB PICkit
4 工具呈红色闪烁状态，表示存在 PTG 错误。

4. 要开始对器件进行编程，应用力按下（但不按住）工具正面 PICkit 4 盾形（徽标）的中心。工具检查器件 ID
后，LED 将变为紫色闪烁状态，指示正在对器件进行编程。

5. 编程完成后，LED 将变回绿色闪烁状态，指示编程/校验操作成功。现在可以进行下一项编程操作。

注： 长按 PICkit 4 按钮可重新初始化工具。该方法可用于在检测到错误后重新初始化 PICkit 4。如果要更换为另一个

包含不同脱机编程映像的 microSDHC 卡，也可以采用这种方法。

LED 状态序列

当 PICkit 4 处于脱机编程模式并正确连接到目标板时，会发生以下序列：

状态 含义

黄色快速闪烁 初始化电源设置。

绿色闪烁 PICkit™ 4 准备好进行编程或编程成功完成。

紫色闪烁 正在进行编程。

红色闪烁 初始化期间的错误：

• 未检测到 microSDHC 卡。

• microSDHC 卡格式不受支持。当设置“send image to tool”时，

MPLAB® X IDE 或 MPLAB IPE 应会报告该错误。

• microSDHC 卡上未找到初始化文件。检查 microSDHC 卡中是否存

在脱机编程映像。

编程期间的错误：

• 电源设置不正确。例如，PICkit 4 工具正在供电，但它检测到来自目

标板的 VDD。或者，本来应该由目标板供电，但 PICkit 工具未检测
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状态 含义

到来自目标板的 VDD，则 LED 将呈红色闪烁状态，表示发生意外事

件。

• 存储器校验错误。

• 器件 ID 不匹配。

• 用于编程的数据文件未找到或已损坏。

5.5 退出脱机编程模式
要退出脱机编程模式，请将 MPLAB PICkit 4 设备插入到 PC USB 端口并连接到 MPLAB X IDE 或 MPLAB IPE。启动

任何非 PTG 操作（例如，编程和擦除等），将显示以下消息：

“The PICkit 4 is currently in programmer to go mode.If you continue with this operation, the PICkit 4 will exit
programmer to go mode.Would you like to continue?”（PICkit 4 现在处于脱机编程模式。如果继续执行此操作，则

PICkit 4 将退出脱机编程模式。是否要继续？）

选择 Yes（是），退出脱机编程模式。
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6. 疑难解答
如果 MPLAB PICkit 4 在线调试器在工作过程中出现问题，请从此处开始故障诊断。

6.1 要首先回答的一些问题
1. 使用的是哪款器件？

要支持新的器件，通常需要将 MPLAB X IDE 升级到较新的版本。

2. 您使用的是 Microchip 的演示板还是您自己设计的电路板？您是否遵循了用于通信连接的电阻/电容的准则？

请参见 3.  工作原理。

3. 您是否已为目标板供电？

调试器无法为目标板提供大于 50 mA 的电流。对于需要超过 50 mA 电流的应用，请使用外部电源为目标板供

电。

4. 您是否在设置中使用了 USB 集线器？它是否已上电？

如果仍有问题，请尝试不使用集线器来连接调试器（将调试器直接插入计算机）。

5. 您是否使用了随调试器一起提供的 USB 线缆？

其他 USB 线缆可能质量差、过长或不支持 USB 通信。

6.2 无法调试的首要原因
1. 振荡器不工作。检查与振荡器有关的配置位设置。如果使用的是外部振荡器，请尝试使用内部振荡器。如果使

用的是内部 PLL，请确保 PLL 的设置正确。

2. 目标板未上电。检查电源线缆连接。

3. VDD 电压不正确。VDD 电压超出该器件规范。更多详细信息，请参见器件编程规范。

4. 断开物理连接。调试器已断开与计算机和/或目标板的物理连接。检查通信线缆的连接。

5. 通信中断。调试器与 PC 的通信已中断。在 MPLAB X IDE 或 MPLAB IPE 中重新连接调试器。

6. 器件未安装到位。器件未正确安装在目标板上。如果调试器连接正确并且目标板已通电，但器件未安装或未完

全插入，则可能会收到以下消息：Target Device ID (0x0) does not match expected Device ID
(0x%x)（目标器件 ID（0x0）与预期器件 ID（0x%x）不匹配），其中%x为预期器件 ID。

7. 器件受到代码保护。检查配置位设置，确认是否使能了代码保护。

8. 应用程序代码损坏。目标应用程序损坏或包含错误。尝试重新编译和重新编程目标应用程序。然后对目标板进
行上电复位。

9. 编程引脚不正确。没有在配置位中正确编程 PGC/PGD 引脚对（对于带多个 PGC/PGD 引脚对的器件）。

10. 需要额外的设置。其他配置设置干扰调试。任何阻止目标器件执行代码的配置设置同样会阻止调试器将代码置
于调试模式。

11. 欠压电压不正确。欠压检测电压大于工作电压 VDD。这意味着器件处于复位状态，不能调试。

12. 连接不正确。请参见 3.  工作原理中的准则了解正确的通信连接。

13. 请求无效。调试器无法始终执行请求的操作。例如，如果目标应用程序正在运行，则调试器无法设置断点。

6.3 需要考虑的其他事项

6.3.1 一般信息

1. 错误可能只发生一次。重试操作。

2. 通常，编程可能会出现问题。作为测试，使用 图标切换为运行模式，然后向目标器件烧写一个尽可能简单

的应用程序（例如，使 LED 闪烁的程序）。如果程序没有运行，则说明目标设置存在错误。

3. 目标器件可能因某种原因（如过流）遭到损坏。开发环境明显对元器件不利。请考虑尝试使用另一个目标板。

Microchip 提供了各种演示板来支持大部分 Microchip 单片机。考虑使用已知可以正常工作的一个应用程序来验

证 MPLAB® PICkit™ 4 在线调试器的功能是否正确。
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4. 查看调试器设置以确保应用设置正确。有关更多信息，请参见 3.  工作原理。

5. 可能为您的电路设置了过高的编程速度。在 MPLAB X IDE 中，转至 File > Project Properties，在 Categories
中选择 PICkit 4，然后选择 Program Options（编程选项）及 Program Speed（编程速度），从相应下拉菜单

中选择一个较慢的速度。默认设置为 Normal（正常），见下图。

图 6-1. Program Speed 选项

6. 在某些情况下，调试器可能无法正常运行，可能需要下载固件或需要重新编程调试器。请参见以下部分以确定

其他操作。

6.3.2 如何调用自举模式

如果 MPLAB X IDE 或 MPLAB IPE 无法与调试器通信，则可能需要强制调试器进入自举模式（下载新固件）。一些可

能的原因如下：

• 6.3.1.  一般信息中的步骤 1-5 没有更正调试器问题。

• MPLAB X IDE 的 Output 窗口在应用程序版本号旁边显示星号（*），说明调试器的固件不是最新版本。

如果 Project Properties Firmware（项目属性固件）选项未选中“Use Latest Firmware”（使用最新固件）复选

框，而 MPLAB X IDE 版本有新固件版本可用，则会发生这种情况。

在这种情况下，请选中“Use Latest Firmware”复选框，然后单击 MPLAB X IDE 仪表板显示中的 Refresh

Debug Tool（刷新调试工具）图标 。如果应用程序版本号旁边仍有星号，或者未解决调试器问题，请继

续执行以下步骤以进入自举模式。

此外，有关灯带模式和自举程序错误的更多信息，请参见 11.2.2.  指示灯带。

执行以下步骤以强制调试器进入自举模式：

1. 将 Micro-B USB 线缆从调试器断开。

2. 按下 MPLAB PICkit 4 徽标，并在插入 Micro-B USB 线缆时保持按住状态。灯带将呈紫色闪烁状态。继续按下

徽标，直到灯带停止闪烁并变为紫色常亮状态。您现在处于自举模式。
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3. 尝试重新与 MPLAB X IDE 或 MPLAB IPE 建立通信。如果成功，将下载最新的固件。完成后，LED 呈蓝色常亮

状态，调试器准备好开始工作。

6.3.3 如何使用硬件工具紧急引导固件恢复实用程序

WARNING 仅使用此实用程序将硬件工具引导固件恢复为出厂状态。仅在硬件工具不能在任何计算机上运行时使用。

在极少数情况下，可能需要强制调试器进入恢复引导模式（重新编程）；例如，如果在调试器连接到计算机时发生以

下任何情况：

• 调试器没有点亮任何 LED。

• 6.3.2.  如何调用自举模式中描述的步骤不成功。

必须使用 MPLAB X IDE v4.15 或更高版本才能使用紧急恢复实用程序。

请严格遵循 MPLAB X IDE 中主菜单选项 Debug > Hardware Tool Emergency Boot Firmware Recovery（调试 > 硬件

工具紧急引导固件恢复）下的说明进行操作。

图 6-2. 选择紧急实用程序

下图给出了紧急恢复按钮在 MPLAB PICkit 4 在线调试器上的位置。

图 6-3. 紧急恢复按钮

如果该过程成功，则恢复向导将显示成功画面。MPLAB PICkit 4 现在可以运行，并且能够与 MPLAB X IDE 通信。

如果该过程失败，请再次尝试。如果第二次仍然失败，请通过 support.microchip.com 与 Microchip 技术支持联系。
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7. 常见问题解答
本章提供有关 MPLAB PICkit 4 在线调试器系统的常见问题的解答。

7.1 工作原理

芯片中的什么组件允许其与 MPLAB PICkit 4 在线调试器通信？

MPLAB PICkit 4 在线调试器可通过 ICSP 接口与闪存芯片通信。它使用下载到程序存储器或测试存储区中的调试执行

程序。

必须运行调试执行程序对处理器吞吐量会有什么影响？

运行模式下，调试执行程序并不运行，因此在运行代码时不会降低吞吐量，即调试器不会占用目标器件的任何周期。

MPLAB PICkit 4 在线调试器是否具有与其他在线仿真器/调试器一样的复杂断点？

没有。但您可以根据数据存储单元或程序地址中的值来暂停程序执行。

MPLAB PICkit 4 在线调试器是否具有复杂断点？

有。您可以根据数据存储单元中的值来暂停程序执行。如果在暂停程序执行前有多个事件发生，还可以设置顺序断点

序列。但只能设置两个序列。此外，还可以设置 AND 条件以及执行 PASS 计数。

MPLAB PICkit 4 在线调试器是否采用光隔离或电隔离？

未采用。您不能对当前系统施加悬浮电压或高压（120V）。

MPLAB PICkit 4 在线调试器是否会降低程序的运行速度？

不会。器件将以数据手册中指定的任何器件速度运行。

可以调试以任何速度运行的 dsPIC DSC 器件吗？

MPLAB PICkit 4 在线调试器能够以器件数据手册中指定的任何器件速度进行调试。

7.2 出现的问题

考虑以下方面：

编程器件后，执行校验失败。这是编程问题吗？

如果选中 Run Main Project 图标（ ），则器件将在编程后立即自动运行。因此，如果代码对闪存存储器进行

了更改，校验可能会失败。要阻止代码在编程后立即运行，请选择 Hold in Reset（保持复位）。

我的计算机进入掉电/休眠模式，并且现在调试器无法工作。这是怎么回事？

长时间使用调试器时（尤其是用作调试器时），请确保在计算机操作系统的“电源选项”对话框窗口中禁止休眠模

式。转到休眠选项卡，并取消选中“启用休眠”复选框。这可确保保持所有 USB 子系统组件之间的所有通信。

我已将外设设置为暂停时不冻结，但它却突然发生冻结。这是怎么回事？

对于 dsPIC30F/33F 和 PIC24F/H 器件，外设控制寄存器中的一个保留位（通常为 bit 14 或 bit 5）由调试器用作

Freeze（冻结）位。如果您对整个寄存器执行过写操作，那么您可能改写了此位（在调试模式下，用户可访问此

位）。

为避免上述问题，请只在应用程序中对想要更改的位执行写操作（通过 BTS和 BTC），而不是对整个寄存器执行写操

作（通过 MOV）。

使用 16 位器件时，发生了意外复位。如何确定复位的原因？

考虑以下几个方面：

• 要确定复位源，请检查 RCON 寄存器。
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• 在中断服务程序（Interrupt Service Routine，ISR）中处理陷阱/中断。应包括 trap.c样式的代码，例如

void __attribute__((__interrupt__)) _OscillatorFail(void);
        : 
void __attribute__((__interrupt__)) _AltOscillatorFail(void);
        : 
void __attribute__((__interrupt__)) _OscillatorFail(void)
    {
        INTCON1bits.OSCFAIL = 0;        //Clear the trap flag
        while (1);
    }
        : 
    void __attribute__((__interrupt__)) _AltOscillatorFail(void)
    {
        INTCON1bits.OSCFAIL = 0;
        while (1);
    }
    :

• 使用 ASSERT。例如：ASSERT (IPL==7)
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8. 错误消息
MPLAB PICkit 4 在线调试器会产生各种不同的错误消息；其中一些错误消息比较特殊，而其他的都可以用常规纠正措

施解决。通常，请阅读错误消息下面的所有指示信息。如果无法解决问题或者无指示信息，请参见以下章节。

8.1 错误消息类型

8.1.1 调试器到目标器件的通信错误
Failed to send database（无法发送数据库）

如果收到这个错误：

• 尝试重新下载。该错误可能只发生一次。

• 尝试手动下载编号最高的.jam文件。

如果无法解决问题或者无指示信息，请参见 8.2.3.  调试器与计算机的通信错误纠正措施。

8.1.2 损坏/过时安装错误

Failed to download firmware（无法下载固件）

如果存在 hex 文件：

• 重新连接并重试。

• 如果无法解决问题，则表明该文件可能已损坏。重新安装 MPLAB X IDE 或 MPLAB IPE。

如果不存在 hex 文件：

• 重新安装 MPLAB X IDE 或 MPLAB IPE。

Unable to download debug executive（无法下载调试执行程序）

如果尝试调试时收到此错误：

1. 取消将调试器选作调试工具。

2. 关闭项目，然后关闭 MPLAB X IDE 或 MPLAB IPE。
3. 重新启动 MPLAB X IDE 或 MPLAB IPE，然后重新打开项目。

4. 重新选择调试器作为调试工具并再次尝试编程目标器件。

Unable to download program executive（无法下载编程执行程序）

如果尝试编程时收到此错误：

1. 取消将调试器选作编程器。

2. 关闭项目，然后关闭 MPLAB X IDE 或 MPLAB IPE。
3. 重新启动 MPLAB X IDE 或 MPLAB IPE，然后重新打开项目。

4. 重新选择调试器作为编程器并再次尝试编程目标器件。

如果无法解决问题或者无指示信息，请参见安装损坏纠正措施。

8.1.3 调试失败错误
The target device is not ready for debugging.Please check your Configuration bit settings and program the
device before proceeding.（目标器件未准备好调试。请检查配置位设置并编程器件，然后继续。）

如果您在对器件进行初次编程之前便尝试运行，将收到此消息。如果在这种情况下收到此消息，或者在编程器件后立

即收到此消息，请参见 8.2.6.  调试失败纠正措施。

器件受到代码保护。

您尝试进行操作（读、编程、空白检查或校验）的器件受到代码保护，即，无法读或修改代码。检查配置位设置，确

认是否使能了代码保护（Windows > Target Memory Views > Configuration Bits（窗口 > 目标存储器视图 > 配置

位））。
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要禁止代码保护，请根据器件数据手册，在代码或 Configuration Bits 窗口中置 1 或清零相应的配置位。然后擦除并重

新编程整个器件。

如果这些操作无法解决问题，请参见调试器到目标器件的通信错误纠正措施和 8.2.6.  调试失败纠正措施。

8.1.4 其他错误

MPLAB PICkit 4 is busy. Please wait for the current operation to finish.（MPLAB PICkit 4 忙。请等待当前操作

完成。）

如果在尝试取消将调试器选作调试器或编程器时收到此错误：

1. 等待。使调试器有时间完成任何应用程序任务。然后重新尝试取消选择调试器。

2. 选择 （结束调试器会话）来停止所有运行中的应用程序。然后重新尝试取消选择调试器。

3. 将调试器从计算机上拔下。然后重新尝试取消选择调试器。

4. 关闭 MPLAB X IDE。

8.1.5 错误消息列表

表 8-1. 按字母顺序排列的错误消息列表

AP_VER=算法插件版本

AREAS_TO_PROGRAM=将编程以下存储区：

AREAS_TO_READ=将读取以下存储区：

AREAS_TO_VERIFY=将校验以下存储区：

BLANK_CHECK_COMPLETE=空白检查完成，器件空白。

BLANK_CHECK_FAILED=空白检查失败。器件不是空白的。

BLANK_CHECKING=正在进行空白检查……

BOOT_CONFIG_MEMORY=引导配置存储器

BOOT_VER=引导版本

BOOTFLASH=引导闪存

BP_CANT_B_DELETED_WHEN_RUNNING=目标器件运行时无法移除软件断点。所选断点将在下次目标器件暂停

执行时移除。

CANT_CREATE_CONTROLLER=无法找到工具控制器类。

CANT_FIND_FILE=无法找到文件%s 的位置。

CANT_OP_BELOW_LVPTHRESH=所选电压%f 低于最小擦除电压%f。此电压下无法继续工作。

CANT_PGM_USEROTP=调试工具无法编程用户 OTP 存储器，因为它不是空白的。请从要编程的存储器中排除用户

OTP 存储器或切换到具有空白用户 OTP 存储器的器件。

CANT_PRESERVE_PGM_MEM=无法保留程序存储器：无效范围起始地址 = %08x，结束地址 = %08x。

CANT_READ_REGISTERS=无法读取目标寄存器。

CANT_READ_SERIALNUM=无法读取器件序列号。

CANT_REGISTER_ALTERNATE_PNP=无法针对多个 USB 产品 ID 注册 PNP 事件。

CANT_REMOVE_SWPS_BUSY=ICD 4 当前繁忙，此时无法移除软件断点。

CHECK_4_HIGH_VOLTAGE_VPP=注意：检查 MPLAB® IDE 中选择的器件（%s）是否与物理连接到调试工具的器

件相同。如果在连接 3.3V 器件时选择 5V 器件，则会导致调试器检查器件 ID 时损坏器件。是否希望继续操作？
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CHECK_PGM_SPEED=您已将编程速度设置为%s。电路板上的电路可能要求您减慢速度。请在工具属性中将设置

更改为“低”并再次尝试操作。

CHECK_SLAVE_DEBUG=调试可能失败，因为尚未使能主项目的从内核设置中的“Debug”复选框。请确保已使能

此设置。

COMM_PROTOCOL_ERROR=调试工具已出现通信错误。工具将复位且应尽快重新枚举。

COMMAND_TIME_OUT=PICkit™ 4 等待命令%02x 的响应超时。

CONFIGURATION=配置

CONFIGURATION_MEMORY=配置存储器

CONNECTION_FAILED=连接失败

CORRUPTED_STREAMING_DATA=检测到无效的数据流。运行时观察或跟踪数据可能不再有效。建议重启您的调

试会话。

CPM_TO_TARGET_FAILED=ControlPointMediator.ToTarget()期间出现异常。

DATA_FLASH_MEMORY=数据闪存存储器

DATA_FLASH=数据闪存

DEBUG_INFO_PGM_FAILED=无法进入调试模式，因为调试信息编程失败。配置位的无效组合可能会导致这一问

题。

DEBUG_READ_INFO=受目标振荡器速度的影响，在调试模式下读取器件可能会花费较长时间。缩小要读取的范围

（在 ICD 4 项目属性下）可缓解这一情况。中止操作可用于在必要时终止读操作。

DEVICE_ID_REVISION=器件 ID 版本

DEVICE_ID=器件 ID

DEVICE_INFO_CONFIG_BITS_MASK=地址 = %08x，掩膜 = %08x

DEVICE_INFO_MEMBERS=器件信息：pcAddress = %08x，Vpp = %.2f，useRowEraseIfVoltageIsLow = %s，
voltageBelowWhichUseRowErase = %.2f，deviceName = %s，programmerType = %s

DEVICE_INFO_MEMINFO_MEMBERS= 器件信息：mask = %04x，exists = %s，startAddr = %08x，endAddr =
%08x，rowSize = %04x，rowEraseSize = %04x，addrInc = %04x，widthProgram = %04x

DEVICE_INFO=器件信息：值：

DEVID_MISMATCH=目标器件 ID（0x%x）是无效的器件 ID。请检查与目标器件的连接。

DFU_NOT_SUPPORTED=MPLAB X 检测到连接的工具具有此版本不支持的功能。请下载最新版本的 MPLAB X 以

使用此工具。

DISCONNECT_WHILE_BUSY=工具在繁忙时断开。

EEDATA_MEMORY=EEData 存储器

EEDATA=EEData

EMPTY_PROGRAM_RANGES=编程操作未完成，因为未选择任何存储区。

EMULATION_MEMORY_READ_WRITE_ERROR=尝试读/写 MPLAB 的仿真存储器时出现错误：地址=%08x

END=结束

ENSURE_SELF_TEST_READY=请确保 RJ-11 线缆连接到测试板后再继续。

ENSURE_SELF_TEST_READY=请确保 RJ-11 线缆连接到测试板后再继续。是否要继续？

ENV_ID_GROUP=器件标识
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ERASE_COMPLETE=擦除成功

ERASING=擦除中……

FAILED_2_PGM_DEVICE=器件编程失败。

FAILED_CREATING_COM=无法创建通信对象。

FAILED_CREATING_DEBUGGER_MODULES=初始化失败：创建调试器模块失败。

FAILED_ERASING=器件擦除失败。

FAILED_ESTABLISHING_COMMUNICATION=无法建立工具通信。

FAILED_GETTING_DBG_EXEC=尝试加载调试执行程序时出现问题。

FAILED_GETTING_DEVICE_INFO=初始化失败：检索器件数据库（.pic）信息时失败

FAILED_GETTING_EMU_INFO=初始化失败：仿真数据库信息获取失败

FAILED_GETTING_HEADER_INFO=初始化失败：调试头数据库信息获取失败

FAILED_GETTING_PGM_EXEC=尝试加载编程执行程序时出现问题

FAILED_GETTING_TEX=无法获取 ToolExecMediator

FAILED_GETTING_TOOL_INFO=初始化失败：检索工具数据库（.ri4）信息时失败

FAILED_INITING_DATABASE=初始化失败：无法初始化工具数据库对象

FAILED_INITING_DEBUGHANDLER=初始化失败：无法初始化 DebugHandler 对象

FAILED_PARSING_FILE=固件文件%s 解析失败

FAILED_READING_EMULATION_REGS=仿真存储器读取失败。

FAILED_READING_MPLAB_MEMORY=无法读取%s 存储器的%0x08 至%0x08 部分。

FAILED_READING_SECURE_SEGMENT=读取安全段配置位失败

FAILED_SETTING_PC=无法设置 PC。

FAILED_SETTING_SHADOWS=无法正确设置影子寄存器。

FAILED_SETTING_XMIT_EVENTS=无法同步运行时数据信号量。

FAILED_STEPPING=对目标器件单步执行失败。

FAILED_TO_GET_DEVID=器件 ID 获取失败。请确保目标器件已连接并再次尝试操作。

FAILED_TO_INIT_TOOL=PICkit 4 初始化失败

FAILED_UPDATING_BP=断点更新失败：文件：%s，地址：%08x

FAILED_UPDATING_FIRMWARE=无法正确更新固件。

FILE_REGISTER=文件寄存器

FIRMWARE_DOWNLOAD_TIMEOUT=固件下载过程期间 PICkit 4 超时。

FLASH_DATA_MEMORY=闪存数据存储器

FLASH_DATA=闪存数据

FRCINDEBUG_NEEDS_CLOCKSWITCHING=要在调试模式下使用 FRC，必须使能时钟切换配置位设置。请使能

时钟切换并重试所请求的操作。

FW_DOESNT_SUPPORT_DYNBP=当前 PICkit 4 固件不支持为所选器件设置运行时断点。请下载固件版

本%02x.%02x.%02x 或更高版本。
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GOOD_ID_MISMATCH=目标器件 ID（0x%x）是有效器件 ID，但与选择的预期器件 ID（0x%x）不匹配。

HALTING=暂停中……

HIGH=高电平

HOLDMCLR_FAILED=保持复位失败。

IDS_SELF_TEST_BOARD_PASSED=PICkit 4 正常工作。如果您的目标电路仍存在问题，请参见在线帮助中的

Target Board Considerations（目标板注意事项）部分。

IDS_ST_CLKREAD_ERR=测试接口 PGC 时钟线读取失败。

IDS_ST_CLKREAD_NO_TEST=测试接口 PGC 时钟线读取未经测试。

IDS_ST_CLKREAD_SUCCESS=测试接口 PGC 时钟线读取成功。

IDS_ST_CLKWRITE_ERR=测试接口 PGC 时钟线写入失败。请确保测试器连接正确。

IDS_ST_CLKWRITE_NO_TEST=测试接口 PGC 时钟线写入未经测试。

IDS_ST_CLKWRITE_SUCCESS=测试接口 PGC 时钟线写入成功。

IDS_ST_DATREAD_ERR=测试接口 PGD 数据线读取失败。

IDS_ST_DATREAD_NO_TEST=测试接口 PGD 数据线读取未经测试。

IDS_ST_DATREAD_SUCCESS=测试接口 PGD 数据线读取成功。

IDS_ST_DATWRITE_ERR=测试接口 PGD 数据线写入失败。

IDS_ST_DATWRITE_NO_TEST=测试接口 PGD 数据线写入未经测试。

IDS_ST_DATWRITE_SUCCESS=测试接口 PGD 数据线写入成功。

IDS_ST_LVP_ERR=测试接口 LVP 控制线故障。

IDS_ST_LVP_NO_TEST=测试接口 LVP 控制线未经测试。

IDS_ST_LVP_SUCCESS=测试接口 LVP 控制线测试成功。

IDS_ST_MCLR_ERR=测试接口 MCLR 电平故障。

IDS_ST_MCLR_NO_TEST=测试接口 MCLR 电平未经测试。

IDS_ST_MCLR_SUCCESS=测试接口 MCLR 电平测试成功。

IDS_TEST_NOT_COMPLETED=接口测试无法完成。请联系您当地的 FAE/CAE 为设备在 SAR 系统中提交请求以进

行维修或替换。

INCOMPATIBLE_FW=REAL ICE™固件与 MPLAB X 软件的当前版本不兼容。

INVALID_ADDRESS=操作无法继续，因为%s 地址超出器件地址范围 0x%08x-0x%08x。

JTAG_NEEDS_JTAGEN=JTAG 适配器需要开启 JTAG 使能配置位。请在继续之前使能此配置位。

MCLR_HOLD_RESET_NO_MAINTAIN_POWER=警告：您正在通过 PICkit 4 为目标器件供电，并且未在 PICkit 4
的 Power（电源）属性页面上选择“Maintain active power”（保持有效供电）选项。如果没有选择此选项，则在当

前会话结束后无法保证 MCLR 的状态（保持/从复位释放）。

MCLR_OFF_ID_WARNING=如果您正在使用低电压编程并且目标器件上的 MCLRE 配置位设置为 OFF，则可以解释

器件 ID 不正确的原因。在这种情况下，请切换到 PICkit 4 Program Options 属性页面上的“Use high voltage
programming mode entry”（使用高电压编程模式）编程模式设置，然后再次尝试操作。

MCLR_OFF_WARNING=如果要继续将 MCLRE 配置位设置为 OFF，请切换到 PICkit 4 Program Options 属性页面

上的“Use high voltage programming mode entry”编程模式设置。

MEM_INFO=器件信息：存储器信息值：
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MEM_RANGE_ERROR_BAD_END_ADDR=收到无效编程范围结束地址%s。请在调试工具的“Memories to
Program”（待编程存储器）属性页面上检查手动编程范围。

MEM_RANGE_ERROR_BAD_START_ADDR=收到无效编程范围起始地址%s。请在调试工具的“Memories to
Program”属性页面上检查手动编程范围。

MEM_RANGE_ERROR_END_LESSTHAN_START=收到无效编程范围：结束地址%s < 起始地址%s。请在调试工

具的“Memories to Program”属性页面上检查手动编程范围。

MEM_RANGE_ERROR_ENDADDR_NOT_ALIGNED=收到无效编程范围：结束地址%s 未对齐到适当的 0x%x 地址

边界。请在调试工具的“Memories to Program”属性页面上检查手动编程范围。

MEM_RANGE_ERROR_STARTADDR_NOT_ALIGNED=收到无效编程范围：起始地址%s 未对齐到适当的 0x%x 地

址边界。请在调试工具的“Memories to Program”属性页面上检查手动编程范围。

MEM_RANGE_ERROR_UNKNOWN=尝试验证用户输入的存储器范围时出现未知错误。

MEM_RANGE_ERROR_WRONG_DATABASE=无法在验证用户输入的存储器范围时访问数据对象。

MEM_RANGE_OUT_OF_BOUNDS=所选编程范围%s 未在所选存储区的正确范围内。请在调试工具的“Memories
to Program”属性页面上检查手动编程范围。

MEM_RANGE_STRING_MALFORMED=在“Memories to Program”属性页面上输入的存储器范围（%s）未采用

正确格式。

MISSING_BOOT_CONFIG_PARAMETER=无法在数据库中找到引导配置起始/结束地址。

MUST_NOT_USE_LVP_WHEN_LVPCFG_OFF=MPLAB 检测到器件上的低电压配置位已关闭，并且您已在调试工

具的属性页面上选择了低电压编程选项。如果要使用低电压编程选项，必须首先执行以下操作：1) 关闭调试工具的

Program Options 属性页面上的低电压编程选项，2) 将低电压配置位编程为开启，3) 开启调试工具的 Program
Options 属性页面上的低电压编程选项。

MUST_SET_LVPBIT_WITH_LVP=低电压编程功能需要在目标器件上使能 LVP 配置位。请使能此配置位并再次尝试

操作。

NEW_FIRMWARE_NO_DEVICE=正在下载固件。

NEW_FIRMWARE=现在为目标器件（%s）下载新固件：%s

NMMR=NMMR

NO_DYNAMIC_BP_SUPPORT_AT_ALL=当前器件不支持在器件运行时设置断点。断点将在下次运行器件之前应

用。

NO_PGM_HANDLER=无法编程软件断点。编程处理程序尚未初始化。

NO_PROGRAMMING_ATTEMPTED=MPLAB 的存储器空白，因此未尝试编程操作。

NORMAL=正常

OP_FAILED_FROM_CP=所请求的操作失败，因为器件受到代码保护。

OpenIDE-Module-Name=PICkit 4

OPERATION_INFO_MEMBERS=操作信息：类型 = %s，掩膜 = %08x，擦除 = %s，生产模式 = %s。

OPERATION_INFO_TRANSFER_INFO_MEMBERS=操作信息：起始地址 = %x，结束地址 = %x，缓冲区长度 =
%d，类型 = %s，掩膜 = %08x。

OPERATION_INFO=操作信息：值：

OPERATION_NOT_SUPPORTED=所选器件不支持此操作

OUTPUTWIN_TITLE=PICkit 4

PERIPHERAL=外设
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POWER_ERROR_NO_9V=配置为从工具向目标板供电，但未检测到 9V 电源插孔。请确保外部 9V 桶形插孔连接到

工具。

POWER_ERROR_NO_POWER_SRC=配置为目标板自行供电，但 VDD 上未检测到任何电压。请确保您已为目标板

供电并重试。

POWER_ERROR_POWER_SRC_CONFLICT=配置为从工具向目标板供电，但 VDD 上已检测到电压。这是一种冲

突。请确保目标板未在向工具提供电压并重试。

POWER_ERROR_SLOW_DISCHARGE=VDD 上似乎有多余的电容，导致系统放电变慢和关闭。考虑最大程度减小

总电容负载或使用来自目标板的电源来避免放电延时。

POWER_ERROR_UNKNOWN=发生未知电源错误。

POWER_ERROR_VDD_TOO_HIGH=所需 VDD 电压超出范围。它超出 5.5V 的最大电压。

POWER_ERROR_VDD_TOO_LOW=所需 VDD 电压超出范围。它低于 1.5V 的最小电压。

POWER_ERROR_VPP_TOO_HIGH=所需 VPP 电压超出范围。它超出 14.2V 的最大电压。

POWER_ERROR_VPP_TOO_LOW=所需 VPP 电压超出范围。它低于 1.5V 的最小电压。

PRESERVE_MEM_RANGE_ERROR_BAD_END_ADDR=收到无效保留范围结束地址%s。请在调试工具的

“Memories to Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_ERROR_BAD_START_ADDR=收到无效保留范围起始地址%s。请在调试工具的

“Memories to Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_ERROR_END_LESSTHAN_START=收到无效保留范围：结束地址%s < 起始地

址%s。请在调试工具的“Memories to Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_ERROR_ENDADDR_NOT_ALIGNED=收到无效保留范围：结束地址%s 未对齐到适当

的 0x%x 地址边界。请在调试工具的“Memories to Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_ERROR_STARTADDR_NOT_ALIGNED=收到无效保留范围：起始地址%s 未对齐到适

当的 0x%x 地址边界。请在调试工具的“Memories to Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_ERROR_UNKNOWN=尝试验证用户输入的保留范围时发生未知错误。

PRESERVE_MEM_RANGE_ERROR_WRONG_DATABASE=无法在验证用户输入的存储器范围时访问数据对象。

PRESERVE_MEM_RANGE_MEM_NOT_SELECTED=您已选择保留一个存储区，但尚未选择编程该存储区。请在

调试工具的“Memories to Program”属性页面上检查保留范围，并确保也指定对任何保留的存储区进行编程。

PRESERVE_MEM_RANGE_OUT_OF_BOUNDS=所选保留范围%s 未在所选存储区的正确范围内。请在调试工具的

“Memories to Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_STRING_MALFORMED=在“Memories to Program”属性页面上输入的保留存储器范

围（%s）未采用正确格式。

PRESERVE_MEM_RANGE_WONT_BE_PROGRAMMED_AUTO_SELECT=在“Memories to Program”属性页面

上输入的保留存储器范围（%s）的部分或全部未处于所选存储器的指定编程范围（%s）内。请取消选中“Memories
to Program”属性页面上的“Auto select memories and ranges”（自动选择存储器和范围）选项，切换到手动模式

并相应地调整范围。

PRESERVE_MEM_RANGE_WONT_BE_PROGRAMMED=在“Memories to Program”属性页面上输入的保留存储

器范围（%s）的部分或全部未处于所选存储器的指定编程范围（%s）内。请在调试工具的“Memories to
Program”属性页面上检查保留范围。

PROGRAM_CFG_WARNING=警告：您已选择编程配置存储器。将无效值编程到任何配置字段中可能会导致意外后

果。请确保每个配置字段都有一个有效值。如果您不确定，可以先从器件读取配置值，然后仅更改您关注的字段。是

否要继续编程？

PROGRAM_COMPLETE=编程/校验完成
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PROGRAM_MEMORY=程序存储器

PROGRAM=编程

PROGRAMMING_DID_NOT_COMPLETE=编程未完成。

READ_COMPLETE=读取完成

READ_DID_NOT_COMPLETE=读取未完成。

RELEASEMCLR_FAILED=从复位释放失败。

REMOVING_SWBPS_COMPLETE=软件断点删除完成

REMOVING_SWBPS=正在删除软件断点……

RESET_FAILED=器件复位失败。

RESETTING=正在复位……

RISKY_CFG_RANGE_REMOVED=配置存储器不包含在编程操作中，因为设置了“Exclude configuration memory
from programming”（从编程中排除配置存储器）选项。要更改此设置，请转到 Memories to Program 属性页面，

取消选中该设置。警告：如果未正确设置所有配置值，则在此器件上编程配置值可能会导致意外后果。建议先从器件

读取配置值，然后仅更改您关注的字段。

RUN_INTERRUPT_THREAD_SYNCH_ERROR=发生内部运行错误。建议重启您的调试会话。您可以继续运行，但

某些运行时功能可能无法正常工作。

RUN_TARGET_FAILED=无法运行目标器件。

RUNNING=正在运行

SERIAL_NUM=序列号：

SETTING_SWBPS=正在设置软件断点.......

STACK=堆栈

START_AND_END_ADDR=起始地址 = 0x%x，结束地址 = 0x%x

START=起始

TARGET_DETECTED=检测到目标电压

TARGET_FOUND=找到目标器件%s。

TARGET_HALTED=目标器件暂停执行

TARGET_NOT_READY_4_DEBUG=目标器件未准备好调试。请检查配置位设置并编程器件，然后继续。此故障最

常见的原因是振荡器和/或 PGC/PGD 设置。

TARGET_VDD=目标 VDD：

TEST=测试

TOOL_INFO_MEMBERS=工具信息：speedLevel = %d，PGCResistance = %d，PGDResistance = %d，
PGCPullDir = %s，PGDPullDir = %s，ICSPSelected = %s。

TOOL_INFO=工具信息：值：

TOOL_IS_BUSY=PICkit 4 繁忙。请等待当前操作完成。

TOOL_SUPPLYING_POWER=PICkit 4 正在为目标板供电（%.2fV）。

TOOL_VDD=VDD：

TOOL_VPP=VPP：
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UNABLE_TO_OBTAIN_RESET_VECTOR=PICkit 4 无法检索复位向量地址。这表示未定义_reset 符号，因此可能阻

止器件正常启动。

UNKNOWN_MEMTYPE=存储器类型未知

UNLOAD_WHILE_BUSY=PICkit 4 在繁忙时被卸载。在再次使用 PICkit 4 之前，请拔下并重新连接 USB 线缆。

UPDATING_APP=正在更新固件应用程序……

UPDATING_BOOTLOADER=正在更新固件自举程序。

USE_LVP_PROGRAMMING=注：如果要使用低电压编程对此器件进行编程，请在此对话框中选择 Cancel（取

消）。然后转到项目属性的 PICkit 4 节点，并选中 Program Options 选项类别窗格的 Enable Low Voltage
Programming（使能低电压编程）复选框（低电压编程对调试操作无效）。

USERID_MEMORY=用户 ID 存储器

USERID=用户 ID

VERIFY_COMPLETE=校验成功。

VERIFY_FAILED=校验失败

VERSIONS=版本

VOLTAGE_LEVEL_BAD_VALUE_EX=您已在 PICkit 4 Power 属性页面上为电压大小输入了无效值%s。请在继续操

作之前解决此问题。

VOLTAGE_LEVEL_BAD_VALUE=无法解析电压大小%s。请输入有效的电压。

VOLTAGE_LEVEL_OUT_OF_RANGE=您输入的目标电压大小%.3f 超出了器件的范围（%.3f - %.3f）。

VOLTAGES=电压

WOULD_YOU_LIKE_TO_CONTINUE=是否要继续？

WRONG_PICkit 4_FLAVOR=您的 PICkit 4 硬件需要更新，请联系 PICkit 4_Update@microchip.com 获取替换件。

8.2 常规纠正措施

8.2.1 读/写错误纠正措施

如果收到读或写错误：

1. 是否单击了 Debug > Reset？此操作可能产生读/写错误。

2. 重试操作。该错误可能只发生一次。

3. 确保目标板已上电并且器件的电压正确。有关所需器件电压，请参见器件数据手册。

4. 确保调试器到目标器件的连接正确（PGC 和 PGD 已连接）。

5. 对于写错误，确保在调试器的 Program Options 上选中“Erase all before Program”（编程之前全部擦除）

（见 10.2.2.  Debug）。

6. 确保所使用的线缆的长度正确。

8.2.2 调试器与目标器件的通信错误纠正措施

如果 MPLAB PICkit 4 在线调试器与目标器件之间不能通信：

1. 选择 Debug > Reset，然后重试操作。

2. 确保所使用的线缆的长度正确。

8.2.3 调试器与计算机的通信错误纠正措施

如果 MPLAB PICkit 4 在线调试器与 MPLAB X IDE 或 MPLAB IPE 之间不能通信：
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1. 从计算机上拔下调试器，然后重新插入。

2. 重新连接调试器。

3. 重试操作。该错误可能只发生一次。

4. 所安装的 MPLAB X IDE 或 MPLAB IPE 版本可能与 MPLAB PICkit 4 在线调试器上加载的固件版本不一致。按

8.2.4.  安装损坏纠正措施中概述的步骤操作。

5. 计算机 USB 端口可能存在问题。请参见 8.2.5.  USB 端口通信错误纠正措施部分。

8.2.4 安装损坏纠正措施

该问题很可能是由于 MPLAB X IDE 或 MPLAB IPE 的安装不完整或者损坏引起的。

1. 卸载计算机上所有的 MPLAB X IDE 或 MPLAB IPE 版本。

2. 重新安装所需的 MPLAB X IDE 或 MPLAB IPE 版本。

3. 如果问题依然存在，请联系 Microchip 技术支持。

8.2.5 USB 端口通信错误纠正措施

该问题很可能是由于通信端口故障或者不存在引起的。

1. 重新连接 MPLAB PICkit 4 在线调试器。

2. 确保调试器已物理连接到计算机上适当的 USB 端口。

3. 确保在调试器选项中选择了适当的 USB 端口（见 10.2.  调试器选项选择）。

4. 确保 USB 端口未被其他设备使用。

5. 如果使用 USB 集线器，请确保已将其上电。

6. 确保已加载 USB 驱动程序。

8.2.6 调试失败纠正措施

MPLAB PICkit 4 在线调试器无法执行调试操作。引发此错误的可能原因很多。请参见 6.2.  无法调试的首要原因和

6.3.  需要考虑的其他事项。

8.2.7 内部错误纠正措施

内部错误难以预料并且不应该发生。它们用于 Microchip 内部开发。

最可能的原因是安装损坏（8.2.4.  安装损坏纠正措施）。

另一个可能的原因是系统资源不足。

1. 尝试重新启动系统以释放存储空间。

2. 确保硬盘上有足够的可用空间（而且没有过多的磁盘碎片）。

如果问题依然存在，请联系 Microchip 技术支持。
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9. 工程技术说明（Engineering Technical Notes，ETN）
以下 ETN 与 MPLAB® PICkit™ 4 在线调试器相关。有关详细信息，请参见产品网页。

ETN37：有关 MPLAB PICkit 4 VPP 过冲修改文档，可访问 MPLAB PICkit 4 产品网页（www.microchip.com/
Developmenttools/ProductDetails/PG164140）。
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10. 调试器功能汇总
下面列出了 MPLAB PICkit 4 在线调试器功能的汇总。

10.1 调试器选择与切换

使用 Project Properties 对话框可为项目选择或切换调试器。要进行切换，必须有多个调试器与计算机相连。MPLAB X
IDE 将通过显示不同序列号来区分各个调试器。

要选择或更改项目使用的调试器：

1. 通过执行下列一项操作打开 Project Properties 对话框：

a. 单击 Projects 窗口中的项目名称，然后选择 File > Project Properties。
或

b. 右键单击 Projects 窗口中的项目名称并选择 Properties。
2. 在左侧的 Categories 下，展开“Conf:[default]”以显示 PICkit 4。
3. 在 Hardware Tools（硬件工具）下，找到 PICkit 4 并单击序列号（Serial Number，SN）来选择项目中使用的

调试器，然后单击 Apply。

10.2 调试器选项选择

在 Project Properties 对话框中设置调试器选项。在 Categories 下单击 PICkit 4，显示 Options for PICkit 4（见下

图）。使用 Options categories（选项类别）下拉列表选择不同的选项。单击某个选项的名称可在下面的 Option
Description（选项说明）框中查看其说明。单击选项名称的右侧可对其进行选择或更改。

注： 可用的选项类别以及这些类别中的选项取决于您选择的器件。

图 10-1. MPLAB® PICkit™ 4 的选项

设置选项后，单击 Apply 或 OK。还需单击 MPLAB X IDE 仪表板显示中的 Refresh Debug Tool 图标 ，更新所做

的任何更改。

可能的选项类别有：

• 10.2.1.  Memories to Program
• 10.2.2.  Debug
• 10.2.3.  Program
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• 10.2.4.  Freeze Peripherals（冻结外设）

• 10.2.5.  Power
• 10.2.6.  Programmer-To-Go
• 10.2.7.  Secure Segment（安全段）

• 10.2.8.  Tool Pack Selection
• 10.2.9.  Clock（时钟）

• 10.2.10.  Communication（通信）

10.2.1 Memories to Program
选择目标器件中要编程的存储器。下表显示了所有可能的选项，但只有可用于您所选器件的选项将显示在 MPLAB X
IDE 中。

注： 如果选择 10.2.3.  Program 中所述的 Erase All Before Program，则编程前将擦除所有器件存储器。

表 10-1. Memories to Program 选项类别

Auto select memories and ranges（自

动选择存储器和范围）

Allow PICkit 4 to Select Memories（允许 PICkit 4 选择存储器）——调试

器根据选择的器件和默认设置确定要编程的存储器和范围。Manually
select memories and ranges（手动选择存储器和范围）——选择要编程

的存储器的类型和范围（见下文）。

Configuration Memory（配置存储器） 选中时可将配置存储器包含在要编程的区域中。始终在调试模式下编程该存
储器。

Boot Flash（引导闪存） 选中时可将引导闪存存储器包含在要编程的区域中。始终在调试模式下编程
该存储器。

EEPROM 选中时可将 EEPROM 存储器包含在要编程的区域中。

ID 选中时可编程用户 ID。

程序存储器 选中时可编程下面指定的目标程序存储器范围。

Program Memory Range(s) (hex)（程

序存储器范围（十六进制））

要编程的程序存储器的范围。具体来说，是程序存储器中要编程、读取或校

验的起始和结束十六进制地址范围。每个范围必须是两个十六进制数（范围

的起始地址和结束地址），这两个数用短划线隔开。多个范围之间必须用逗

号隔开（例如 0-ff, 200-2ff）。范围必须对齐到 0x800 地址边界。

注： 地址范围不适用于擦除功能。擦除功能将擦除器件上的所有数据。

Preserve Program Memory（保留程序

存储器）

使能该选项将使器件上的当前程序存储器读入 MPLAB X IDE 的存储区，然

后在编程完成后重新编程回目标器件。将保留的程序存储器的范围由下面的
Preserve Program Memory Range(s)（保留程序存储器范围）选项确定。

确保代码不受代码保护。

Preserve Program Memory Range(s)
(hex)（保留程序存储器范围（十六进

制））

要保留的程序存储器的范围。每个范围必须是两个十六进制数（表示范围的

起始地址和结束地址），这两个数用短划线隔开。多个范围之间必须用逗号

隔开（例如 0-ff, 200-2ff）。要保留区域的保留方式是将其读入 MPLAB X
IDE，然后在进行编程操作时将其编程回原来的区域。因此，保留区域必须

位于将被编程的存储器范围内。

Preserve (Type of) Memory（保留（类

型）存储器）

使能该选项将使器件上的当前存储器类型读入 MPLAB X IDE 的存储区，然

后在编程完成后重新编程回目标器件。选中时会保留 Memory 以对其进行重

新编程，其中 Memory 为存储器类型。类型包括：EEPROM 存储器、ID 存

储器、引导闪存和辅助存储器。确保代码不受代码保护。
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Preserve (Type of) Memory Range(s)
(hex)（保留（类型）存储器范围（十

六进制））*

要保留的存储器类型的范围。每个范围必须是两个十六进制数（表示范围的

起始地址和结束地址），这两个数用短划线隔开。多个范围之间必须用逗号

隔开（例如 0-ff, 200-2ff）。要保留区域的保留方式是将其读入 MPLAB X
IDE，然后在进行编程操作时将其编程回原来的区域。因此，保留区域必须

位于将被编程的存储器范围内。Memory 为存储器类型，包括 EEPROM 存

储器、ID 存储器、引导闪存和辅助存储器。确保代码不受代码保护。

*如果您收到因不正确范围引起的编程错误，确保范围未超过可用/剩余器件存储器的范围。

10.2.2 Debug
您可以选择使用软件断点（如果此选项可用于项目所使用器件）。

表 10-2. Debug 选项类别

Use Software Breakpoints（使用软件断

点）

选中时可使用软件断点。取消选中则使用硬件断点。请参见下表，以确

定哪种断点类型适合您的应用。

表 10-3. 软件断点与硬件断点

特性 软件断点 硬件断点

断点数 无限 有限

断点写入到 程序存储器 调试寄存器

设置断点的时间 取决于振荡器速度——可能需要数分
钟

极短

断点滑移（Skidding） 无 有

注： 使用软件断点进行调试会影响器件的耐用性。因此，建议不要将以这种方式使用过的器件用作生产器件。

10.2.3 Program
选择在编程前擦除整个存储器还是合并代码。

表 10-4. Program 选项类别

Erase All Before Program 使能该选项将导致在从 MPLAB X IDE 编程数据之前擦除整个器件。编程器件

时，任何指定为保留的存储区都将在器件被擦除前读取并重新编程到器件。除非

编程新器件或已擦除的器件，否则都必须选中此复选框。若未选中此复选框，将

不对器件执行擦除操作并且程序代码将与器件中已存在的代码合并。

Programming mode entry（编程

模式进入）

该选项指定调试器用于将目标器件置于编程模式的方法。对于低电压编程方法，

VPP 不会超过 VDD 电源电压，而会对 VPP 使用测试模式。对于高电压编程方法，

将对 VPP 施加超过 9V 的电压。

注： 高电压编程需要 VDD 高于 2.8V。如果目标电压低于 2.8V，则选择低电压编

程。

高电压编程模式进入的目标电压范围——2.8V 至 5.0V。

仅低电压编程模式进入的目标电压范围——1.2V 至 5.0V。

LED Brightness Setting（LED 亮

度设置）

选择从 1（最暗）到 10（最亮）的亮度等级。

PGC Configuration（PGC 配置） 此选项确定将应用于 PGC 线的电阻类型（下拉、上拉或无）。默认为下拉。电

阻值由下面的 PGC 电阻值选项决定。

PGC resistor value (kΩ)（PGC 电

阻值（kΩ））

输入 0-50 之间的电阻值。默认值为 4.7 kΩ。如果 PGC 配置设置为 none
（无），则忽略该值。
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PGD Configuration（PGD 配置） 选择 none、pull up（上拉）或 pull down（下拉）。默认为下拉。电阻值由下面

的 PGD 电阻值选项决定。

PGD resistor value (kΩ)（PGD 电

阻值（kΩ））

输入 0-50 之间的电阻值。默认值为 4.7 kΩ。如果 PGD 配置设置为 none，则忽

略该值。

Program Speed 选择调试器编程目标器件时所使用的速度，即 Low（低速）、Normal（正常速

度）或 High（高速）。默认为 Normal。如果编程失败，则使用低速可能会解决

问题。

10.2.4 Freeze Peripherals（冻结外设）

从外设列表中选择程序暂停时冻结或不冻结的外设。可用外设取决于器件。

PIC12/16/18 MCU 器件

要在暂停时冻结/取消冻结所有器件外设，请选中/取消选中“Freeze on Halt”（暂停时冻结）复选框。如果这并未使

所需外设暂停，请注意，某些外设没有暂停时冻结功能，因而无法受调试器控制。

dsPIC、PIC24 和 PIC32 器件

选中“Peripherals to Freeze on Halt”（暂停时冻结的外设）列表中某外设的复选框，可在暂停时将其冻结。取消选

中外设可使其在程序暂停时运行。如果未在列表中看到某个外设，则选中“All Other Peripherals”（所有其他外

设）。如果这并未使所需外设暂停，请注意，某些外设没有暂停时冻结功能，因而无法受调试器控制。

要选择包括“All Other Peripherals”在内的所有外设，则单击 Check All（全部选中）。要取消选择包括“All Other
Peripherals”在内的所有外设，则单击 Uncheck All（全部取消选中）。

10.2.5 Power
选择电源选项。

表 10-5. Power 选项类别

Power Target Circuit from PICkit 4
（通过 PICkit™ 4 为目标电路供

电）

如果选中该选项，则将允许通过 PICkit 4 为目标电路供电。否则必须使用外部

电源（见 3.2.4.  调试器供电）。

Voltage Level（电压大小） 如果选中“Power Target Circuit from PICkit 4”复选框，则可选择调试器提供

的目标 VDD。

10.2.6 Programmer-To-Go
选择 Programmer-To-Go 选项。

表 10-6. Programmer-To-Go 选项类别

Image Name 默认映像名称为“<your project name>_ptg”，但也可根据需要编辑名称。这将是 microSDHC 卡

上的文件夹名称，其中包含脱机编程的相关文件。

Send image to
tool

该复选框默认处于选中状态。选中该复选框后，将创建 PTG 映像，然后将其发送到所连接的

MPLAB PICkit 4 中插入的 microSDHC 卡。

Program
Device

该复选框默认处于选中状态。选中该复选框后，将对连接到 MPLAB PICkit 4 的器件进行编程。

10.2.7 Secure Segment（安全段）

选择和加载调试器固件。
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表 10-7. Secure Segment 选项类别

Segments to be Programmed（要编程的

段）

选择以下其中一个选项：

1. Full Chip Programming（全片编程）（默认）。

2. Boot, Secure and General Segments（引导段、安全段和通用

段）。

3. Secure and General Segments（安全段和通用段）。

4. General Segment Only（仅通用段）。

10.2.8 Tool Pack Selection
选择和加载调试器固件。

表 10-8. Tool Pack Selection 类别

Tool pack update options（工具包更

新选项）

选择 Use latest installed tool pack（使用最新安装的工具包）（推荐）或

Use specific tool pack（使用特定工具包）。

Specifically selected version（选择特

定版本）

按下后可选择要使用的工具包。按下后，将打开 Select Tool pack（选择工具

包）对话框，可从中选择所需的版本。

10.2.9 Clock（时钟）

设置此选项可为所选器件使用内部快速 RC（Fast RC，FRC）时钟。

表 10-9. Clock 选项类别

Use FRC in Debug mode (dsPIC33F
and PIC24F/H devices only)（在调试

模式下使用 FRC（仅限 dsPIC33F 和

PIC24F/H 器件））

调试时，使用器件内部快速 RC（FRC）而不是为应用指定的振荡器来提供时

钟。这在应用时钟较慢时十分有用。
选中此复选框将使应用以低速运行，但以更快的 FRC 速度进行调试。

更改此设置后重新编程。

注： 在调试时，未冻结的外设将以 FRC 速度运行。

10.2.10 Communication（通信）

设置适用于您的器件和目标通信类型的选项。

表 10-10. Communication 选项类别

Interface（接口） 从可用选项中选择接口。

Speed (MHz)（速度（MHz）） 根据接口适用的速度范围输入速度。

高电压激活模式 该选项仅针对具有该选项的 AVR®器件显示。No High Voltage（无高电压）

——默认设置。 Simple High Voltage Pulse（简单高电压脉冲）——该工具

将尝试通过发出高电压脉冲来激活接口。如果引脚配置为输入，则该过程是

安全的。User Power Toggle（用户电源切换）——在该模式下，系统将提

示用户切换目标器件的电源。一旦工具检测到电源恢复，它将在配置目标器

件引脚之前发出高电压脉冲，从而使激活过程尽可能平稳。

使用 UPDI 对 AVR 器件进行编程

MPLAB PICkit 4 支持使用高电压机制激活 AVR 统一编程和调试接口（Unified Program and Debug Interface，
UPDI）。在具有 UPDI 的低引脚数 AVR 器件上，可通过配置 RSTPINCFG 配置位将 UPDI 引脚配置为 GPIO 或

RESET。为了进行进一步的编程，MPLAB PICkit 4 将必须使用高电压脉冲来重新激活 UPDI 接口。使用高电压脉冲

时，必须确保连接到 UPDI 线的所有电路都可以承受至少 12V 的脉冲。

GPIO 与 UPDI 操作：
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当使用高压脉冲重新激活 UPDI 接口时，重新激活只是暂时的，但是它将保持 UPDI 功能直到下一次复位。下一次复位

之后，引脚将返回到 RSTPINCFG 配置位指定的配置。要在复位后将引脚配置为 UPDI，用户必须将 RSTPINCFG 配

置位更改回 UPDI。

将 RSTPINCFG 配置为 GPIO 时，可以执行调试会话，但引脚将临时配置为 UPDI，不能用作 GPIO 引脚。

表 10-11. SYSCFG0 RSTPINCFG[1:0]配置位

值 功能

0x0 GPIO

0x1 UPDI

0x2 RESET

0x3 保留
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11. 硬件规范
本章详述了 MPLAB PICkit 4 在线调试器系统的硬件规范和电气规范。

11.1 USB 连接器
MPLAB PICkit 4 在线调试器通过符合 USB 2.0 版本的 Micro-B USB 连接器与主机计算机连接。Micro-B USB 连接器

位于调试器的顶部。

系统能够通过 USB 接口重载固件。

通过 USB 接口为系统供电。根据 USB 规范，该调试器被归类为大功率系统，需要通过 USB 提供略大于 50 mA 的电

流，才能使该调试器在所有工作模式（调试器/编程器）下正常工作。

注： MPLAB PICkit 4 在线调试器通过其 Micro-B USB 连接器供电。目标板则由自身电源供电。或者，也可由调试器

为目标板供电，但仅限目标板消耗的电流小于 50 mA 时。

线缆长度——在调试器工具包里随附了正常工作所需长度的计算机-调试器连接线缆。

供电的集线器——如果您想使用 USB 集线器，请确保它是自供电的。此外，计算机键盘上的 USB 端口不能为调试器

正常工作提供足够的功率。

计算机休眠/掉电模式——禁止计算机上的休眠或其他节能模式，以确保与调试器的正常 USB 通信。

11.2 MPLAB PICkit 4 在线调试器
调试器包含一个内部主电路板、一个外部 Micro-B USB 连接器和一个 8 引脚 SIL 连接器。调试器外壳的正面有一个指

示灯带和一个隐藏按钮，按钮位于徽标下面。
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图 11-1. MPLAB® PICkit™ 4 在线调试器

1. 挂绳连接——穿过顶部和侧面的开孔，用于连接挂绳（不提供挂绳）。

2. 紧急恢复按钮——如果需要，此内凹按钮可用于恢复引导模式。

3. Micro-B USB 连接器——用于使用随附的 USB 线缆将调试器连接到计算机。

4. 指示灯带——显示调试器的工作模式（见 11.2.2.  指示灯带）。

5. 按钮区域——盾形徽标中心的区域，用于脱机编程 1 选项以及用于调用自举模式（见 6.3.2.  如何调用自举模

式）。

6. 引脚 1 标记——指示引脚 1 的位置，以便正确对齐连接器。

7. 编程连接器——该连接器是一个 8 引脚 SIL 连接器（0.100"间距），用于连接目标器件（见 11.3.2.  接口的引脚

分配）。

8. MicroSDHC 卡插槽 1——microSDHC 卡插槽支持具有各种速度要求的多种 microSDHC 卡。

注： 1 将来通过 MPLAB X IDE 对产品进行更新提供此功能。

11.2.1 主电路板

主电路板具有以下特性：

• 一个使用 Arm Cortex-M4 内核的 32 位单片机。

• 一个 USB 速度最高达 480 Mbps 的 USB 2.0 接口。

• 一个用于保存程序代码映像的 SRAM。此映像用于编程板上闪存器件。

• 一个 LED 灯带。

11.2.2 指示灯带

MPLAB PICkit 4 调试器预期的启动序列为：
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1. 紫色——常亮约 4 秒钟。

2. 蓝色——常亮。调试器就绪。

指示灯带具有如下含义。

表 11-1. 指示灯带的典型状态说明

颜色 说明

蓝色 电源已连接；调试器处于待机状态。

橙色 已选中 Power target circuit from PICkit 4。

绿色 未选中 Power target circuit from PICkit 4。

红色 调试器故障时点亮。

下面的两个表列出了指示灯和自举程序错误的说明。

表 11-2. 指示灯带的附加状态说明

颜色 说明

蓝色 电源已连接；调试器处于待机状态。

橙色 已选中 Power target circuit from PICkit 4（见表 10-5）。

绿色 未选中 Power target circuit from PICkit 4（见表 10-5）。

紫色 自举程序正在运行。

黄色 调试器忙。

红色 操作失败。

紫色 快速闪烁表示强制调试器进入自举模式的时间窗口。

表 11-3. 自举程序错误说明

自举程序错误 说明

红色，慢速闪烁 访问调试器的串行 EEPROM 时上电。

红色，快速闪烁 无法处理自举程序 API 命令。

白色，快速闪烁 工具固件出现运行时异常。

11.3 通信硬件
对于调试器与目标板的标准通信（见 3.1.  调试器与目标板之间的通信和 3.1.1.  标准 ICSP 器件通信），可以直接将调

试器连接到目标板。调试器有一个 8 引脚 SIL 连接器。如果目标板具有 6 引脚连接器，请确保正确对齐引脚 1。

11.3.1 标准通信

调试器与目标处理器的主接口采用标准通信方式。它包含与高电压（VPP）线和 VDD 检测线的连接，以及编程和连接目

标器件所需的时钟和数据连接。

VPP 高电压线可生成电压范围为 0V 至 14V 的可变电压，以满足特定仿真处理器的电压要求。

VDD 检测连接从目标处理器汲取极少的电流。实际功率来自 MPLAB PICkit 4 在线调试器系统，因为 VDD 检测线仅用作

参考来跟踪目标电压。

时钟和数据连接是具有以下特性的接口：

• 时钟和数据信号为高阻模式（即使在未向 MPLAB PICkit 4 在线调试器系统供电时也是如此）。

• 时钟和数据信号不受因故障目标系统或不当连接引起的高电压的影响。
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• 时钟和数据信号不受因故障目标系统中出现短路而引起的大电流的影响。

表 11-4. 电气逻辑表

逻辑输入 VIH = VDD x 0.7V（最小值）

VIL = VDD x 0.3V（最大值）

逻辑输出 VDD = 5V VDD = 3V VDD = 2.3V VDD = 1.4V

VOH = 3.8V（最小

值）

VOH = 2.4V（最小

值）

VOH = 1.9V（最小

值）

VOH = 1.0V（最小

值）

VOL = 0.55V（最大

值）

VOL = 0.55V（最大

值）

VOL = 0.3V（最大

值）

VOL = 0.1V（最大

值）

图 11-2. MPLAB® PICkit™ 4 调试器连接器引脚分配

11.3.2 接口的引脚分配

对于不同的器件和接口，编程连接器引脚功能有所不同。有关调试和数据流接口，请参见以下引脚分配表。

注： 有关更多信息和图，请参见所用器件的数据手册以及特定接口的应用笔记。
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表 11-5. 调试接口的引脚分配

MPLAB PICkit 4 调试
连
接
器 引

脚
编
号

引脚
名称

ICSP
（MCHP）

MIPS
EJTAG

Cortex®
SWD

AVR®
JTAG

AVR ISP
（&DW）

UPDI PDI AW debugWIRE TPI

1 TVPP MCLR MCLR MCLR

2 TVDD VDD VIO_REF VTG VTG VTG VTG VTG VTG VTG VTG

3 GND GND GND GND GND GND GND GND GND GND GND

4 PGD DAT TDO SWO TDO MISO DAT DAT DATA DAT

5 PGC CLK TCK SWCLK TCK SCK CLK

6 TAUX AUX RESET RESET CLK dW RST

7 TTDI TDI TDI MOSI

8 TTMS TMS SWDIO TMS

表 11-6. 数据流接口的引脚分配

MPLAB PICkit 4 数据流

引脚编号 DMCI/DGI1 U(S)ART/CDC DGI1 SPI

1

2 VTG

3 GND

4 MISO

5 SCK

6 （SCK）

7 TX（目标） MOSI

8 RX（目标） SS

1. 供将来使用。

__________________

图 11-3. 调试器适配器板（AC102015）引脚分配

此连接板支持 JTAG、SWD、ICSP 和 AVR 协议。
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11.4 目标板注意事项
应根据所选器件和应用的要求向目标板供电。

注： 如果器件的工作条件超过器件数据手册“电气特性”一章中的“绝对最大值”，可能对器件造成永久性损坏。上

述值仅代表本规范规定的极限工作条件，不代表器件在上述极限值或超出极限值的情况下仍可正常工作。器件长时间

工作在最大值条件下，其可靠性可能受到影响。

调试器检测目标电压。

根据调试器与目标板之间使用的通信类型，目标板电路有以下注意事项：

• 3.2.2.  目标板连接电路

• 3.2.5.  阻止调试器正常工作的电路
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12. 版本历史

12.1 版本 A（2018 年 5 月）
本文档的初始版本。

12.2 版本 B（2018 年 8 月）
• 在 2.3.  MPLAB PICkit 4 在线调试器组件中增加了有关调试适配器板的信息。

• 扩展了表 11-5 以包含其他接口的引脚分配。

• 在 11.3.2.  接口的引脚分配和 3.2.  目标板通信连接中增加了一个注，提示您参考器件数据手册和调试接口的应用

笔记。

12.3 版本 C（2018 年 10 月）
• 更新了图 11-2 中的图表。

• 更新了表 11-5 中的信息。

• 增加了图 11-3，提供了与 PICkit 4 和各种接口配合使用的调试器适配器板（AC102015）的引脚分配信息。

12.4 版本 D（2020 年 1 月）
• 增加了 10.2.6.  Programmer-To-Go 部分并更新了整个文档中对脱机编程的引用。

• 更新了 MPLAB PICkit 4 的图。

• 增加了 9.  工程技术说明（Engineering Technical Notes，ETN）部分。

• 修改了目标电压值。

12.5 版本 E（2020 年 2 月）
• 在 2.2.  MPLAB PICkit 4 在线调试器的优势和表 10-4 中阐明了低电压和高电压编程模式电压值范围。

12.6 版本 F（2020 年 10 月）
• 在“调试器功能汇总”中增加了 Tool Pack Selection 选项（10.2.8.  Tool Pack Selection），代替了 Firmware 选

项。

• 为清楚起见，将表 11-5 中的 dW 更改为 debugWIRE
• 在表 11-6 中增加了对 TX 和 RX 接口的说明以及相关注释

12.7 版本 G（2021 年 10 月）
• 通篇删除了对调试头的引用，并增加了 MPLAB PICkit 4 不支持调试头的“注”。

 
版本历史

© 2019-2022 Microchip Technology Inc.
及其子公司

 用户指南 DS50002751G_CN-第 57 页



13. 支持

13.1 保修登记
请访问 www.microchip.com/mysoftware 在线注册工具。如果您尚未拥有 myMicrochip 帐户，可以单击该链接进行注

册。如果您已经拥有一个帐户，请登录并单击 Register Hardware Tool（注册硬件工具）。

在线注册工具后，您便可以收到新产品更新信息。可在 Microchip 网站上获得临时软件版本。

13.2 myMicrochip 个性化通知服务
Microchip 的个性化通知服务有助于客户了解关于所关注 Microchip 产品的最新信息。注册客户可在指定产品系列或开

发工具发生变更、更新、发布新版本或勘误表时，收到电子邮件通知。

如需注册并选择接收个性化通知的首选项，请转至：

www.microchip.com/pcn

该网页提供 FAQ 和注册详细信息。
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14. 术语表

Absolute Section（绝对段）

具有链接器不能改变的固定（绝对）地址的 GCC 编译器段。

Absolute Variable/Function（绝对变量/函数）

使用 OCG 编译器的@ address 语法放置在绝对地址的变量或函数。

Access Memory（快速存取存储区）

仅限 PIC18——PIC18 器件中的一些特殊寄存器，对这些寄存器的访问与存储区选择寄存器（Bank Select Register，
BSR）的设置无关。

Access Entry Point（访问入口点）

访问入口点提供了一种方法，可跨段将控制转移到某个可能未在链接时定义的函数。它们支持独立链接引导段和安全

应用程序段。

Address（地址）

标识存储器中位置的值。

Alphabetic Character（字母字符）

字母字符指属于拉丁字母表（a,b,…,z,A,B, …,Z）中字母的字符。

Alphanumeric（字母数字字符）

字母数字字符由字母字符和十进制数字（0,1, …,9）组成。

ANDed Breakpoint（逻辑与断点）

为程序暂停设置“逻辑与”条件，即只有断点 1 和断点 2 同时出现时，才会暂停程序。这只有在数据断点和程序存储

器断点同时发生时才能实现。

Anonymous Structure（匿名结构体）

16 位 C 编译器——未命名的结构体。

PIC18 C 编译器——属于 C 联合体的成员的未命名结构体。匿名结构体成员可以像包含结构体的联合体的成员一样进

行访问。例如，在以下代码中，hi 和 lo 是联合体 caster 中的匿名结构体的成员。

union castaway
int intval;
struct {
char lo; //accessible as caster.lo
char hi; //accessible as caster.hi
};
} caster;

ANSI
美国国家标准学会，是美国负责制订和批准标准的组织。

Application（应用）

可由 PIC®单片机控制的一组软硬件。

Archive/Archiver（归档/归档器）

归档/库是可重定位目标模块的集合。由将多个源文件编译/汇编为目标文件，然后使用归档器/库管理器将目标文件组合

为一个归档/库文件生成。可将归档/库与目标模块和其他归档/库链接，生成可执行代码。
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ASCII
美国信息交换标准码是使用 7 个二进制位来表示每个字符的字符集编码。它包括大写和小写字母、数字、符号以及控

制字符。

Assembly/Assembler（汇编语言/汇编器）

汇编语言是以符号形式描述二进制机器码的编程语言。汇编器是将汇编源代码翻译成机器码的语言工具。

Assigned Section（已分配段）

在链接器命令文件中已分配到目标存储区的 GCC 编译器段。

Asynchronously（异步）

不同时发生的多个事件。通常用来指可能在处理器执行过程中的任意时刻发生的中断。

Asynchronous Stimulus（异步激励）

为模拟传递到软件模拟器件的外部输入而生成的数据。

Attribute（属性）

C 语言程序中变量或函数的 GCC 特性，用于描述特定于机器的性质。

Attribute, Section（属性，段）

段的 GCC 特性，如“可执行”、“只读”或“数据”，它们可在汇编器.section伪指令中指定为标志。

Binary（二进制）

使用数字 0 和 1，以 2 为基数的计数体制。最右边的位表示 1 的倍数，右边第二位表示 2 的倍数，右边第三位表示 22

= 4 的倍数，以此类推。

Bookmarks（书签）

使用书签可轻松地查找文件中的指定行。

在 Editor（编辑器）工具栏中选择 Toggle Bookmarks（开关书签）可添加/删除书签。单击该工具栏上的其他图标可移

动到下一个或上一个书签。

C/C++
C 语言是一种通用编程语言，具有简练的表达式、现代控制流和数据结构，以及丰富的操作符。C++是 C 语言的面向

对象版本。

Calibration Memory（校准存储区）

用于保存 PIC 单片机内 RC 振荡器或其他外设校准值的特殊功能寄存器或通用寄存器。

Central Processing Unit（中央处理单元）

器件的一部分，负责取出要执行的正确指令，对指令进行译码，然后执行指令。如果有必要，它和算术逻辑单元

（Arithmetic Logic Unit，ALU）一起工作来完成指令的执行。它控制程序存储器的地址总线、数据存储器的地址总线

和对堆栈的访问。

Clean（清除）

清除会删除活动项目的所有中间项目文件，例如目标文件、hex 文件和调试文件。编译项目时，将基于其他文件重新创

建这些文件。

COFF
公共目标文件格式。这种格式的目标文件包含机器码、调试及其他信息。
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Command Line Interface（命令行接口）

仅基于文本输入和输出，在程序和其用户之间进行通信的一种方式。

Compiled Stack（编译堆栈）

编译器管理的存储区，用于静态分配变量的空间。当在目标器件上无法高效实现软件或硬件堆栈时，编译堆栈将替代

它们。

Compiler（编译器）

将用高级语言编写的源文件翻译成机器码的程序。

Conditional Assembly（条件汇编）

基于指定表达式在编译时的值包含或忽略的汇编语言代码。

Conditional Compilation（条件编译）

只有当预处理器伪指令指定的某个常量表达式为真时才编译程序段的操作。

Configuration Bits（配置位）

可对其编程来设置 PIC MCU 或 dsPIC DSC 工作模式的专用位。配置位可或不可再编程。

Constant（常量）

表示一个立即数的值，例如通过汇编.equ 伪指令指定的定义。

Control Directive（控制伪指令）

汇编语言代码中根据汇编时指定表达式的值包含或忽略代码的伪指令。

CPU
请参见中央处理单元。

Cross Reference File（交叉引用文件）

引用符号表的一个文件及引用符号的文件的列表。如果定义了符号，列出的第一个文件是定义的位置。其他文件包含

对符号的引用。

Data Directive（数据伪指令）

数据伪指令是那些控制汇编器对程序存储器或数据存储器进行分配的指示性语句，它提供了用符号（即有意义的名

称）引用数据项的方法。

Data Memory（数据存储器）

在 Microchip MCU 和 DSC 器件中，数据存储器（RAM）由通用寄存器（GPR）和特殊功能寄存器（SFR）组成。某

些器件还有 EEPROM 数据存储器。

Data Monitor and Control Interface，DMCI（数据监视与控制界面）

数据监视与控制界面（DMCI）是 MPLAB X IDE 中的一个工具。该界面可以对项目中的应用程序变量提供动态输入控

制。应用程序生成的数据可以使用 4 个可动态分配图形窗口中的任意一个以图形方式进行查看。

Debug/Debugger（调试/调试器）

请参见 ICE/ICD。

Debugging Information（调试信息）

编译器和汇编器选项，在选中时，它们将提供不同程度的信息来用于调试应用程序代码。关于选择调试选项的详细信

息，请参见编译器或汇编器文档。

 
术语表

© 2019-2022 Microchip Technology Inc.
及其子公司

 用户指南 DS50002751G_CN-第 61 页



Deprecated Feature（弃用功能）

由于历史原因仍然支持但最终将逐步淘汰且不再使用的功能。

Device Programmer（器件编程器）

用于对电可编程半导体器件（如单片机）进行编程的工具。

Digital Signal Controller（数字信号控制器）

数字信号控制器（DSC）是具有数字信号处理能力的单片机（即 Microchip 的 dsPIC DSC 器件）。

Digital Signal Processing/Digital Signal Processor（数字信号处理/数字信号处理器）

数字信号处理（DSP）指数字信号以及已转换为数字形式（经过采样的）的一般模拟信号（声音或图像）的计算机处

理。数字信号处理器是设计为用于数字信号处理的微处理器。

Directive（伪指令）

源代码中提供对语言工具的操作进行控制的语句。

Download（下载）

下载是将数据从主机发送到其他设备（如仿真器、编程器或目标板）的过程。

DWARF
使用任意记录格式调试。DWARF 是用于 ELF 文件的调试信息格式。

EEPROM
电可擦除的可编程只读存储器。一种可电擦除的特殊 PROM。一次写或擦除一个字节数据。EEPROM 即使电源关闭时

也能保留内容。

ELF
可执行链接格式。这种格式的目标文件包含机器码。调试和其他信息使用 DWARF 指定。ELF/DWARF 可提供优于

COFF 的优化代码调试。

Emulation/Emulator（仿真/仿真器）

请参见 ICE/ICD。

Endianness（尾数法）

多字节对象中的字节存储顺序。

Environment（环境）

MPLAB PM3——包含关于如何对器件编程的文件的文件夹。该文件夹可以转移到 SD/MMC 卡。

Epilogue
编译器生成代码的一部分，负责释放堆栈空间、恢复寄存器，以及执行运行时模型中指定的任何其他特定于机器的要

求。此代码在给定函数的任何用户代码之后、紧接在函数返回之前执行。

EPROM
可擦除的可编程只读存储器。通常通过紫外线照射来擦除的可编程只读存储器。

Error/Error File（错误/错误文件）

错误报告使程序不能继续处理的问题。而且，当问题比较明显时，错误还尽可能标识出源文件名和行号。错误文件包

含由语言工具生成的错误消息和诊断信息。
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Event（事件）

对可能包含地址、数据、次数计数、外部输入、周期类型（取指和读/写）及时间戳的总线周期的描述。事件用于描述

触发、断点和中断。

Executable Code（可执行代码）

可装入来执行的软件。

Export（导出）

以标准化的格式将数据从 MPLAB IDE/MPLAB X IDE 发送出。

Expression（表达式）

用算术或逻辑运算符分隔开的常量和/或符号的组合。

Extended Microcontroller Mode（扩展单片机模式）

在扩展单片机模式下，既可使用片内程序存储器，也可使用外部存储器。如果程序存储器地址大于 PIC18 器件的内部

存储空间，执行自动切换到外部存储器。

Extended Mode（扩展模式）（PIC18 MCU）

在扩展模式下，编译器将使用扩展指令（即 ADDFSR、ADDULNK、CALLW、MOVSF、MOVSS、PUSHL、SUBFSR和

SUBULNK）以及立即数变址寻址。

External Label（外部标号）

具有外部链接的标号。

External Linkage（外部链接）

如果可以在定义函数或变量的模块外部对函数或变量进行引用，则函数或变量具有外部链接。

External Symbol（外部符号）

具有外部链接的标识符符号。这可能是一个引用或一个定义。

External Symbol Resolution（外部符号解析）

链接器收集所有输入模块的外部符号定义来解析所有外部符号引用的过程。没有相应定义的任何外部符号引用都会导
致报告链接器错误。

External Input Line（外部输入线）

用于根据外部信号设置事件的外部输入信号逻辑探针线（TRIGIN）。

External RAM（外部 RAM）

芯片外部的读/写存储器。

Fatal Error（致命错误）

引起编译立即停止的错误。不产生其他消息。

File Register（文件寄存器）

片内数据存储器，包括通用寄存器（GPR）和特殊功能寄存器（SFR）。

Filter（筛选器）

通过选择确定在跟踪显示或数据文件中包含/排除哪些数据。

Fixup（修正）

在链接器重定位之后，使用绝对地址替换目标文件符号引用的过程。
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Flash（闪存）

按块（而不是按字节）写或擦除数据的一种 EEPROM。

FNOP
强制空操作。强制 NOP 周期是双周期指令的第二个周期。由于 PIC 单片机的架构是流水线型，在执行当前指令的同时

预取物理地址空间中的下一条指令。但是，如果当前指令改变了程序计数器，那么这条预取的指令就被忽略了，导致

一个强制 NOP 周期。

Frame Pointer（帧指针）

引用堆栈中地址，并将基于堆栈的参数和基于堆栈的局部变量分隔开的指针。为访问当前函数的局部变量和其他值提

供了方便。

Free-Standing（独立）

一种接受任何不使用复杂类型的严格符合程序的实现，而且在这种实现中，对库条款（ANSI 89 标准条款第 7 条）中

规定的特性的使用，仅限于标准头文件<float.h>、<iso646.h>、<limits.h>、<stdarg.h>、
<stdbool.h>、<stddef.h>和<stdint.h>的内容。

GPR
通用寄存器。器件数据存储器（RAM）的一部分，作为一般用途。

Halt（暂停）

停止程序执行。执行 Halt 与在断点处停止相同。

Heap（堆）

用于动态存储器分配的存储区，其中的存储器块按运行时确定的任意顺序进行分配和释放。

Hex Code/Hex File（Hex 代码/Hex 文件）

hex 代码是以十六进制格式代码存储的可执行指令。hex 代码包含在 hex 文件中。

Hexadecimal（十六进制）

使用数字 0-9 以及字母 A-F（或 a-f），以 16 为基数的计数体制。字母 A-F 表示值为 10-15（十进制）的十六进制数

字。最右边的位表示 1 的倍数，右边第二位表示 16 的倍数，右边第三位表示 162 = 256 的倍数，以此类推。

High Level Language（高级语言）

编写程序的语言，与汇编语言相比，它不依赖于具体的处理器。

ICE/ICD
在线仿真器/在线调试器：用于对目标器件进行调试和编程的硬件工具。仿真器具有比调试器更多的功能，例如跟踪。

在线仿真/在线调试：使用在线仿真器或调试器进行仿真或调试的行为。

-ICE/-ICD：带有在线仿真或调试电路的器件（MCU 或 DSC）。该器件总是安装在仿真/调试头板上，并用于通过在线

仿真器或调试器进行调试。

ICSP
在线串行编程。使用串行通信和最少数量的器件引脚对 Microchip 嵌入式器件进行编程的方法。

IDE
集成开发环境，如 MPLAB IDE/MPLAB X IDE。

Identifier（标识符）

函数名或变量名。
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IEEE
电气电子工程师协会。

Import（导入）

将数据从外部源（例如，hex 文件）传送到 MPLAB IDE/MPLAB X IDE 中。

Initialized Data（已初始化数据）

用初始值定义的数据。在 C 中，

int myVar=5;
定义了将存放到已初始化数据段中的一个变量。

Instruction Set（指令集）

特定处理器理解的机器语言指令的集合。

Instruction（指令）

告知中央处理单元执行特定操作，并包含操作中要使用的数据的位序列。

Internal Linkage（内部链接）

如果不能从定义函数或变量的模块外部访问它们，则这样的函数或变量具有内部链接。

International Organization for Standardization（国际标准化组织）

制订许多行业和技术（包括计算和通信）方面的标准的一个组织。也称为 ISO。

Interrupt（中断）

传递到 CPU 的信号，它使 CPU 暂停执行正在运行的应用程序，将控制权转交给中断服务程序（ISR），以处理事件。

在完成 ISR 时，将恢复应用程序的正常执行。

Interrupt Handler（中断处理程序）

发生中断时处理特殊代码的子程序。

Interrupt Service Request，IRQ（中断服务请求）

使处理器暂停正常的指令执行并开始执行中断处理程序的事件。某些处理器有几种中断请求事件，允许具有不同优先

级的中断。

Interrupt Service Routine，ISR（中断服务程序）

语言工具：处理中断的函数。

MPLAB IDE/MPLAB X IDE：当产生中断时进入的用户生成代码。代码在程序存储器中的位置通常取决于所产生中断的

类型。

Interrupt Vector（中断向量）

中断服务程序或中断处理程序的地址。

L-value（左值）

引用可被检查和/或修改的对象的表达式。左值表达式用在赋值的左侧。

Latency（响应延时）

事件与其得到响应之间的延迟时间。

Library/Librarian（库/库管理器）

请参见归档/归档器。
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Linker（链接器）

将目标文件和库文件组合起来生成可执行代码并解析一个模块对另外一个模块引用的语言工具。

Linker Script File（链接描述文件）

链接描述文件是链接器的命令文件。它们定义链接选项并描述目标平台上的可用存储器。

Listing Directive（列表伪指令）

列表伪指令是控制汇编器列表文件格式的伪指令。它们允许指定标题、分页及其他列表控制。

Listing File（列表文件）

列表文件是列出为每条 C 源语句生成的机器码、源文件中遇到的汇编指令、汇编器伪指令或宏的 ASCII 文本文件。

Little Endian（小尾数法）

多字节数据的数据存储顺序机制，在这种机制中，低字节存储在较低的地址中。

Local Label（局部标号）

局部标号是用 LOCAL 伪指令在一个宏内部定义的标号。这些标号特定于宏实例化的一个给定实例。也就是说，声明为

local 的符号和标号在遇到 ENDM 宏后不再可访问。

Logic Probe（逻辑探针）

Microchip 的某些仿真器最多可连接 14 个逻辑探针。逻辑探针提供外部跟踪输入、触发输出信号、+5V 和公共接地

端。

Loop-Back Test Board（环回测试板）

用于测试 MPLAB REAL ICE 在线仿真器的功能。

LVDS
低电压差分信号传输。一种通过铜线进行高速（每秒千兆位）数据传输的低噪声、低功耗、低幅值方法。

对于标准 I/O 信号传输，数据存储依赖于实际电压大小。电压值会受线路长度影响（线路越长，电阻就越高，这会使电

压下降）。但对于 LVDS，存储数据仅通过正负电压值判断，而不是实际电压大小。因此，数据可以传输更长的线路距

离，同时保持干净、一致的数据流。

Source: http://www.webopedia.com/TERM/L/LVDS.html

Machine Code（机器码）

处理器实际读和解释的计算机程序的表示。二进制机器码程序由一系列机器指令（可能还包含数据）组成。某个特定

处理器的所有可用指令的集合称为它的“指令集”。

Machine Language（机器语言）

特定中央处理单元的指令集，不需翻译即可供处理器使用。

Macro（宏）

宏指令。以缩写形式表示指令序列的指令。

Macro Directive（宏伪指令）

控制宏定义体中执行和数据分配的伪指令。

Makefile
将用于 Make 项目的指令导出到一个文件中。可使用该文件通过 make 指令在 MPLAB IDE/MPLAB X IDE 外 Make 项

目。
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Make Project（Make 项目）

重新编译应用程序的命令，仅编译自上次编译完成后更改了的源文件。

MCU
单片机。microcontroller 的缩写形式。也写作 uC。

Memory Model（存储器模型）

对于 C 编译器，指应用程序可使用的存储区的表示。对于 PIC18 C 编译器，指一种描述，它指定指向程序存储器的指

针的位数。

Message（消息）

显示出来的文本，警告在语言工具的操作中可能存在的问题。消息不会停止操作。

Microcontroller（单片机）

高度集成的芯片，它包括 CPU、RAM、程序存储器、I/O 端口和定时器。

Microcontroller Mode（单片机模式）

PIC18 单片机的一种程序存储器配置。在单片机模式下，仅允许内部执行。因此，在单片机模式下仅可使用片内程序

存储器。

Microprocessor Mode（微处理器模式）

PIC18 单片机的一种程序存储器配置。在微处理器模式下，不使用片内程序存储器。整个程序存储器映射到外部。

Mnemonic（助记符）

可直接翻译成机器码的文本指令。也称为操作码。

Module（模块）

源文件在执行预处理器伪指令之后的预处理输出。也称为翻译单元。

MPASM™ Assembler（MPASM™汇编器）

Microchip Technology 用于 PIC 单片机、KeeLoq®器件和 Microchip 存储器器件的可重定位宏汇编器。

MPLAB Language Tool for Device（用于器件的 MPLAB 语言工具）

用于指定器件的 Microchip 的 C 编译器、汇编器和链接器。根据应用中所使用的器件来选择语言工具类型。例如，如

果为 PIC18 MCU 编写 C 代码，就选择用于 PIC18 MCU 的 MPLAB C 编译器。

MPLAB ICD
Microchip 的在线调试器，与 MPLAB IDE/MPLAB X IDE 配合使用。请参见 ICE/ICD。

MPLAB IDE/MPLAB X IDE
Microchip 的集成开发环境。MPLAB IDE/MPLAB X IDE 随附编辑器、项目管理器和软件模拟器。

MPLAB PM3
Microchip 的器件编程器。用于对 PIC18 单片机和 dsPIC®数字信号控制器进行编程。可与 MPLAB IDE/MPLAB X IDE
配合使用，也可单独使用。代替 PRO MATE II。

MPLAB REAL ICE™ In-Circuit Emulator（MPLAB REAL ICE™在线仿真器）

Microchip 的新一代在线仿真器，与 MPLAB IDE/MPLAB X IDE 配合使用。请参见 ICE/ICD。

MPLAB SIM
Microchip 的软件模拟器，与 MPLAB IDE/MPLAB X IDE 配合使用，支持 PIC MCU 和 dsPIC® DSC 器件。

 
术语表

© 2019-2022 Microchip Technology Inc.
及其子公司

 用户指南 DS50002751G_CN-第 67 页



MPLAB Starter Kit for Device（用于器件的 MPLAB 入门工具包）

Microchip 的入门工具包中包含着手研究指定器件所需的全部内容。查看有效工作的应用程序，然后调试和编程您自己

的更改。

MPLIB™ Object Librarian（MPLIB™目标库管理器）

Microchip 的库管理器，与 MPLAB IDE/MPLAB X IDE 配合使用。MPLIB 库管理器是用于将由 MPASM 汇编器

（mpasm 或 mpasmwin v2.0）或 MPLAB C18 C 编译器生成的 COFF 目标模块组合成库文件的目标库管理器。

MPLINK™ Object Linker（MPLINK™目标链接器）

MPLINK 链接器是 Microchip MPASM 汇编器和 Microchip C18 C 编译器的目标链接器。也可将 MPLINK 链接器与

Microchip MPLIB 库管理器配合使用。MPLINK 链接器设计为在 MPLAB IDE/MPLAB X IDE 中使用，尽管它也可独立

于 MPLAB IDE/MPLAB X IDE 使用。

MRU
最近使用的。指可从 MPLAB IDE/MPLAB X IDE 主下拉菜单中选择的文件和窗口。

Native Data Size（本机数据大小）

对于本地跟踪，Watches（观察）窗口中使用的变量长度必须与所选器件的数据存储器长度相同：对于 PIC18 器件，

为字节长度；对于 16 位器件，为字长度。

Nesting Depth（嵌套深度）

宏可包含其他宏的最大深度。

Node（节点）

MPLAB IDE/MPLAB X IDE 项目组件。

Non-Extended Mode（非扩展模式）（PIC18 MCU）

在非扩展模式下，编译器不会使用扩展指令和立即数变址寻址。

Non Real Time（非实时）

指处理器处于断点或正在单步执行指令或者 MPLAB IDE/MPLAB X IDE 正运行在软件模拟器模式下。

Non-Volatile Storage（非易失性存储器）

电源关闭时保存其内容的存储器件。

NOP
空操作。执行该指令时，除了程序计数器加 1 外没有任何其他影响。

Object Code/Object File（目标代码/目标文件）

目标代码是由汇编器或编译器生成的机器码。目标文件是包含机器码，也可能包含调试信息的文件。它可以直接执

行；或为可重定位的，需要与其他目标文件（如库文件）链接来生成完全可执行的程序。

Object File Directive（目标文件伪指令）

仅当生成目标文件时使用的伪指令。

Octal（八进制）

使用数字 0-7，以 8 为基数的计数体制。最右边的位表示 1 的倍数，右边第二位表示 8 的倍数，右边第三位表示 82 =
64 的倍数，以此类推。
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Off-Chip Memory（片外存储器）

片外存储器指 PIC18 器件的一种存储器选择，这种情况下存储器可位于目标板上，或所有程序存储器都由仿真器提

供。从 Options>Development Mode（选项>开发模式）访问 Memory 选项卡可打开 Off-Chip Memory Selection（片外

存储器选择）对话框。

Opcode（操作码）

操作码。请参见助记符。

Operator（运算符）

加号“+”和减号“-”之类的符号，它们在构成定义明确的表达式时使用。每个运算符都具有指定的优先级，用于确定

求值的顺序。

OTP
可一次编程。非窗口封装的 EPROM 器件。由于 EPROM 需要紫外线照射来擦除其存储内容，因此只有窗口片是可擦

除的。

Pass Counter（次数计数器）

每次一个事件（如执行特定地址处的一条指令）发生时都会递减 1 的计数器。当次数计数器的值为零时，事件满足。

可将次数计数器分配给断点和跟踪逻辑，以及在 complex trigger（复杂触发）对话框中的任何顺序执行事件。

PC
个人计算机或程序计数器。

PC Host（PC 主机）

运行支持的 Windows 操作系统的任何 PC。

Persistent Data（持久性数据）

永不清除或初始化的数据。其作用是使应用程序可以在器件复位时保存数据。

Phantom Byte（虚拟字节）

dsPIC 架构中的未实现字节，在将 24 位指令字视为 32 位指令字时使用。虚拟字节出现在 dsPIC hex 文件中。

PIC MCU
PIC 单片机（MCU）指 Microchip 的所有单片机系列。

PICkit™ 2 and 3（PICkit 2 和 3）
Microchip 的器件开发编程器，通过 Debug Express 实现调试功能。要了解每个工具支持哪些器件，请参见每个工具的

自述文件。

Plug-in（插件）

MPLAB IDE/MPLAB X IDE 使用内置组件和插件模块来为各种软件和硬件工具配置系统。可在 Tools（工具）菜单下找

到几个插件工具。

Pod（主机）

在线仿真器或调试器的机身。其他名称还有 Puck（如果外壳是圆的）和 Probe（不要与逻辑探针混淆）。

Power-on-Reset Emulation（上电复位仿真）

在应用开始上电时，将随机值写到数据 RAM 区中来模拟 RAM 中的未初始化值的软件随机过程。

Pragma（Pragma 伪指令）

对特定编译器有意义的伪指令。通常一条 pragma 伪指令用于向编译器传达实现定义的信息。
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Precedence（优先顺序）

定义表达式中求值顺序的规则。

Production Programmer（生产编程器）

生产编程器是一种编程工具，其中设计了可对器件进行快速编程的资源。它具有在各种电压下进行编程的能力并完全

符合编程规范。在生产环境中，应用电路需要在组装线上传送，时间是极其重要的，所以尽可能快地对器件编程至关

重要。

Profile（配置文件）

对于 MPLAB SIM 软件模拟器，寄存器已执行激励的汇总列表。

Program Counter（程序计数器）

包含正在执行的指令的地址的存储单元。

Program Counter Unit（程序计数器单元）

16 位汇编器——程序存储器布局的概念化表示。对于每个指令字，程序计数器将递增 2。在可执行段中，2 个程序计

数器单元相当于 3 个字节。在只读段中，2 个程序计数器单元相当于 2 个字节。

Program Memory（程序存储器）

MPLAB IDE/MPLAB X IDE：器件中存储指令的存储区。亦指仿真器或软件模拟器中包含下载的目标应用固件的存储

器。

16 位汇编器/编译器：器件中存储指令的存储区。

Project（项目）

项目包含编译应用程序所需的文件（源代码和链接描述文件等），以及它们与各种编译工具和编译选项的关联。

Prologue
编译器生成代码的一部分，负责分配堆栈空间、保存寄存器，以及执行运行时模型中指定的任何其他特定于机器的要

求。此代码在给定函数的任何用户代码之前执行。

Prototype System（样机系统）

指用户的目标应用或目标板的术语。

Psect
GCC 段的 OCG 等效形式，program section（程序段）的缩写。被链接器视为一个整体的代码块或数据块。

PWM Signal（PWM 信号）

脉宽调制信号。某些 PIC MCU 包含 PWM 外设。

Qualifier（限定符）

次数计数器使用的地址或地址范围，或用作复杂触发中另一个操作之前的事件。

Radix（基数）

数基，十六进制或十进制，用于指定一个地址。

RAM
随机访问存储器（数据存储器）。可以以任意顺序访问这种存储器中的信息。

Raw Data（原始数据）

与一个段有关的代码或数据的二进制表示。
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Read Only Memory（只读存储器）

存储器硬件，它允许快速访问其中永久存储的数据，但不允许添加或修改数据。

Real Time（实时）

当在线仿真器或调试器从暂停状态释放时，处理器以实时模式运行且与芯片的正常操作相同。在实时模式下，使能仿

真器的实时跟踪缓冲区，并持续捕捉所有选择的周期，使能所有断点逻辑。在在线仿真器或调试器模式下，处理器实

时运行，直到有效断点导致暂停，或者直到用户暂停执行。

在软件模拟器模式下，实时仅意味着单片机指令的执行速度与主机 CPU 可模拟的指令速度一样快。

Recursive Call（递归调用）

一个直接或间接调用自身的函数。

Recursion（递归）

已定义的函数或宏可调用自己的概念。当编写递归宏时要特别小心；当递归没有出口时容易陷入无限循环。

Re-entrant（可重入函数）

可以有多个同时运行的实例的函数。在下面两种情况下可能发生函数重入：直接或间接递归调用函数；或者在由函数

转入的中断处理过程中又执行此函数。

Relaxation（精简）

将某一指令转换为功能相同但大小较小的指令的过程。这对于缩短代码长度非常有用。MPLAB XC16 当前知道如何将

CALL 指令精简为 RCALL 指令。当被调用的符号处于当前指令的+/- 32k 指令字范围内时，将会执行该操作。

Relocatable（可重定位）

一个对象，它的地址没有分配到存储器中的固定地址。

Relocatable Section（可重定位段）

16 位汇编器——地址不固定（绝对）的段。链接器通过一个称为重定位的过程来为可重定位段分配地址。

Relocation（重定位）

链接器执行的一个过程，在这个过程中，为可重定位段分配绝对地址，且可重定位段中的所有符号都更新为其新地

址。

ROM
只读存储器（程序存储器）。不能修改的存储器。

Run（运行）

将仿真器从暂停状态释放，允许仿真器实时运行应用代码、实时改变 I/O 状态或实时响应 I/O 的命令。

Run-time Model（运行时模型）

描述目标架构资源的使用。

Run-time Watch（运行时观察）

Watches 窗口，其中的变量会在应用程序运行时更改。要确定如何设置运行时观察，请参见相应的工具文档。并不是

所有工具都支持运行时观察。

Scenario（场景）

MPLAB SIM 软件模拟器用于激励控制的一种特定设置。

Section（段）

OCG psect 的 GCC 等效形式。被链接器视为一个整体的代码块或数据块。
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Section Attribute（段属性）

赋予段的 GCC 特性（例如，access 段）。

Sequenced Breakpoint（顺序断点）

按在序列中的顺序发生的断点。序列中断点的执行顺序为从下到上；序列中的最后一个断点最先执行。

Serialized Quick Turn Programming（序列号快速批量编程）

序列化使您可以将序列号编程到器件编程器进行编程的每个单片机中。该编号可用作记录代码、密码或 ID 号。

Shell
MPASM 汇编器 shell 是宏汇编器的提示输入接口。有两个 MPASM 汇编器 shell：一个针对 DOS 版本，一个针对

Windows 操作系统版本。

Simulator（软件模拟器）

模仿器件操作的软件程序。

Single Step（单步执行）

这一命令单步执行代码，一次执行一条指令。执行每条指令后，MPLAB IDE/MPLAB X IDE 更新寄存器窗口、观察变

量及状态显示，使您可分析和调试指令。也可单步执行 C 编译器源代码，但不是每次执行一条指令，MPLAB IDE/
MPLAB X IDE 将执行一行高级 C 语句生成的所有汇编指令。

Skew
不同时间出现在处理器总线上与指令执行有关的信息。例如，执行前一条指令的过程中取指时，被执行的操作码出现

在总线上；当实际执行该操作码时，源数据地址及其值以及目标数据地址出现在总线上。当执行下一条指令时，目标

数据值出现在总线上。跟踪缓冲区一次捕捉总线上的这些信息。因此，跟踪缓冲区的一条记录将包含三条指令的执行

信息。执行一条指令时，从一条信息到另一条信息的捕捉周期数称为 skew。

Skid
当使用硬件断点来暂停处理器时，在处理器暂停前可能再执行一条或多条指令。断点后执行的指令条数称为 skid。

Source Code（源代码）

编程人员编写计算机程序的形式。采用某种正式的编程语言编写源代码，可翻译成机器码或被解释程序执行。

Source File（源文件）

包含源代码的 ASCII 文本文件。

Special Function Register，SFR（特殊功能寄存器）

数据存储器（RAM）的一部分，专用于控制 I/O 处理器功能、I/O 状态、定时器或其他模式及外设的寄存器。

SQTP
请参见序列号快速批量编程。

Stack, Hardware（堆栈，硬件）

PIC 单片机中调用函数时存储返回地址的存储区。

Stack, Software（堆栈，软件）

用来存储返回地址、函数参数和局部变量的存储区。此存储器由程序中的指令在运行时动态分配。它支持可重入函数
调用。

Stack, Compiled（堆栈，已编译）

编译器管理和分配的存储区域，用于静态分配变量的空间。当在目标器件上无法高效实现软件堆栈时，编译堆栈将替

代软件堆栈。它会阻止重入。

 
术语表

© 2019-2022 Microchip Technology Inc.
及其子公司

 用户指南 DS50002751G_CN-第 72 页



Static RAM or SRAM（静态 RAM 或 SRAM）

静态随机访问存储器。目标板上可读/写且不需要经常刷新的程序存储器。

Status Bar（状态栏）

状态栏位于 MPLAB IDE/MPLAB X IDE 窗口的底部，指示诸如光标位置、开发模式、器件和有效工具栏之类的当前信

息。

Step Into（单步进入）

这一命令与 Single Step 相同。Step Into（与 Step Over 相对）在 CALL 指令后，单步执行子程序。

Step Over（单步跳过）

Step Over 允许调试代码时不单步执行子程序。当 step over 一条 CALL指令时，下一个断点将设置在 CALL指令后的

下一条指令处。如果由于某种原因，子程序陷入无限循环或不正确返回，下一个断点将永远执行不到。除了对 CALL指

令的处理外，Step Over 命令与 Single Step 相同。

Step Out（单步跳出）

Step Out 使您可以跳出当前正在单步执行的子程序。该命令会执行该子程序中的剩余代码，然后在该子程序的返回地

址处停止执行。

Stimulus（激励）

软件模拟器的输入（即为模拟对外部信号的响应而生成的数据）。通常数据采用文本文件中一系列动作的形式。激励

可以是异步的，同步的（引脚），时钟激励和寄存器激励。

Stopwatch（跑表）

测量执行周期的计数器。

Storage Class（存储类别）

确定与指定对象相关联存储区的存在时间。

Storage Qualifier（存储限定符）

指明所声明对象的特殊属性（如 const）。

Symbol（符号）

符号是描述组成程序的不同部分的一种通用机制。这些部分包括函数名、变量名、段名、文件名以及结构/枚举类/联合

标记名等。MPLAB IDE/MPLAB X IDE 中的符号主要指变量名、函数名和汇编标号。链接后符号的值就是其在存储器

中的值。

Symbol, Absolute（符号，绝对）

通过将符号存放到存储器中的特定地址，使其成为绝对符号，例如，int scanMode __at(0x200);。

System Window Control（系统窗口控件）

系统窗口控件位于窗口和某些对话框的左上角。单击该控件时通常会弹出包含“Minimize”（最小化）、

“Maximize”（最大化）和“Close”（关闭）项的菜单。

Target（目标）

指用户硬件。

Target Application（目标应用程序）

目标板上的软件。
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Target Board（目标板）

构成目标应用的电路和可编程器件。

Target Processor（目标处理器）

目标应用板上的单片机。

Template（模板）

为以后插入自己的文件中使用而创建的文本行。MPLAB 编辑器将模板存储到模板文件中。

Toolbar（工具栏）

一行或一列图标，单击这些图标时将执行 MPLAB IDE/MPLAB X IDE 功能。

Trace（跟踪）

记录程序执行的仿真器或软件模拟器功能。仿真器将程序执行记录到其跟踪缓冲区中，该缓冲区的内容将被上传到

MPLAB IDE/MPLAB X IDE 的 trace（跟踪）窗口。

Trace Memory（跟踪存储区）

跟踪存储区包含在仿真器内部。跟踪存储区有时称为跟踪缓冲区。

Trace Macro（跟踪宏）

一个通过仿真器数据来提供跟踪信息的宏。由于该宏属于软件跟踪，所以必须将它添加到代码中、必须重新编译或重

新汇编代码，并且必须使用该代码对目标器件进行编程，之后跟踪才会工作。

Trigger Output（触发输出）

触发输出指可在任意地址或地址范围产生的仿真器输出信号，与跟踪和断点的设置无关。可设置任意个触发输出点。

Trigraph（三字母词）

三字符序列，都以??开头，由 ISO C 定义用于替代单个字符。

Unassigned Section（未分配段）

在链接器命令文件中未分配到特定目标存储区的段。链接器必须找到用于分配未分配段的目标存储区。

Uninitialized Data（未初始化数据）

定义时未指定初始值的数据。在 C 中，

int myVar;
定义了将存放到未初始化数据段的一个变量。

Upload（上传）

上传功能将数据从一个工具（如仿真器或编程器）传送到主机计算机，或将数据从目标板传送到仿真器。

USB
通用串行总线。一种外部外设接口标准，用于通过线缆使用双向串行传输在计算机和外部外设之间进行通信。USB
1.0/1.1 支持 12 Mbps 的数据传输速率。USB 2.0（也称为高速 USB）支持最高 480 Mbps 的数据传输速率。

Vector（向量）

复位或中断发生时应用程序跳转到的存储地址。

Volatile
一个变量限定符，它可以防止编译器应用会影响变量在存储器中的访问方式的优化。
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Warning（警告）

MPLAB IDE/MPLAB X IDE：提醒出现了可能导致器件、软件文件或设备物理损坏的通知。

16 位汇编器/编译器：警告报告可能存在问题的条件，但并不暂停处理。

Watch Variable（观察变量）

调试会话期间可在 Watches 窗口中监控的变量。

Watches Window（Watches 窗口）

Watches 窗口包含一系列观察变量，这些变量在每次执行到断点时更新。

Watchdog Timer，WDT（看门狗定时器）

PIC 单片机中在一段可选择长度的时间后复位处理器的定时器。使用配置位来使能、禁止和设置 WDT。

Workbook（工作簿）

对于 MPLAB SIM 模拟器，是一种用于产生 SCL 激励的设置。
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Microchip 网站

Microchip 网站 www.microchip.com/为客户提供在线支持。客户可通过该网站方便地获取文件和信息。只要使用常用的

互联网浏览器即可访问，网站提供以下信息：

• 产品支持——数据手册和勘误表、应用笔记和示例程序、设计资源、用户指南以及硬件支持文档、最新的软件版
本以及归档软件

• 一般技术支持——常见问题（FAQ）、技术支持请求、在线讨论组以及 Microchip 顾问计划成员名单

• Microchip 业务——产品选型和订购指南、最新 Microchip 新闻稿、研讨会和活动安排表、Microchip 销售办事

处、代理商以及工厂代表列表

变更通知客户服务

Microchip 的变更通知客户服务有助于客户了解 Microchip 产品的最新信息。注册客户可在他们感兴趣的某个产品系列

或开发工具发生变更、更新、发布新版本或勘误表时，收到电子邮件通知。

欲注册，请登录 Microchip 网站 www.microchip.com/。在“支持”（Support）下，点击“变更通知客户”

（Customer Change Notification）服务后按照注册说明完成注册。

客户支持

Microchip 产品的用户可通过以下渠道获得帮助：

• 代理商或代表

• 当地销售办事处

• 应用工程师（FAE）
• 技术支持

客户应联系其代理商、代表或应用工程师（FAE）寻求支持。当地销售办事处也可为客户提供帮助。本文档后附有销售

办事处的联系方式。

也可通过以下网站获得技术支持： www.microchip.com/support

Microchip 器件代码保护功能

请注意以下有关 Microchip 器件代码保护功能的要点：

• Microchip 的产品均达到 Microchip 数据手册中所述的技术指标。

• Microchip 确信：在正常使用的情况下，Microchip 系列产品是当今市场上同类产品中最安全的产品之一。

• 目前，仍存在着恶意、甚至是非法破坏代码保护功能的行为。就我们所知，所有这些行为都不是以 Microchip 数

据手册中规定的操作规范来使用 Microchip 产品的。这样做的人极可能侵犯了知识产权。

• Microchip 愿意与关心代码完整性的客户合作。

• Microchip 或任何其他半导体厂商均无法保证其代码的安全性。代码保护并不意味着我们保证产品是“牢不可破”

的。

代码保护功能处于持续发展中。Microchip 承诺将不断改进产品的代码保护功能。任何试图破坏 Microchip 代码保护功

能的行为均可视为违反了《数字器件千年版权法案（Digital Millennium Copyright Act）》。如果这种行为导致他人在

未经授权的情况下，能访问您的软件或其他受版权保护的成果，您有权依据该法案提起诉讼，从而制止这种行为。

法律声明

提供本文档的中文版本仅为了便于理解。请勿忽视文档中包含的英文部分，因为其中提供了有关 Microchip 产品性能和

使用情况的有用信息。Microchip Technology Inc.及其分公司和相关公司、各级主管与员工及事务代理机构对译文中可

能存在的任何差错不承担任何责任。建议参考 Microchip Technology Inc.的英文原版文档。
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本出版物中所述的器件应用信息及其他类似内容仅为您提供便利，它们可能由更新之信息所替代。确保应用符合技术

规范，是您自身应负的责任。Microchip 对这些信息不作任何明示或暗示、书面或口头、法定或其他形式的声明或担

保，包括但不限于针对其使用情况、质量、性能、适销性或特定用途的适用性的声明或担保。Microchip 对因这些信息

及使用这些信息而引起的后果不承担任何责任。如果将 Microchip 器件用于生命维持和/或生命安全应用，一切风险由

买方自负。买方同意在由此引发任何一切伤害、索赔、诉讼或费用时，会维护和保障 Microchip 免于承担法律责任，并

加以赔偿。除非另外声明，否则在 Microchip 知识产权保护下，不得暗中或以其他方式转让任何许可证。

商标
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Technology Incorporated 在美国和其他国家或地区的注册商标。

AgileSwitch、APT、ClockWorks、The Embedded Control Solutions Company、EtherSynch、FlashTec、Hyper
Speed Control、HyperLight Load、IntelliMOS、Libero、motorBench、mTouch、Powermite 3、Precision Edge、
ProASIC、ProASIC Plus、ProASIC Plus 徽标、Quiet-Wire、SmartFusion、SyncWorld、Temux、TimeCesium、

TimeHub、TimePictra、TimeProvider、WinPath 和 ZL 均为 Microchip Technology Incorporated 在美国的注册商标。

Adjacent Key Suppression、AKS、Analog-for-the-Digital Age、Any Capacitor、AnyIn、AnyOut、Augmented
Switching、BlueSky、BodyCom、CodeGuard、CryptoAuthentication、CryptoAutomotive、CryptoCompanion、
CryptoController、dsPICDEM、dsPICDEM.net、Dynamic Average Matching、DAM、ECAN、Espresso T1S、
EtherGREEN、IdealBridge、In-Circuit Serial Programming、ICSP、INICnet、Intelligent Paralleling、Inter-Chip
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VeriPHY、ViewSpan、WiperLock、XpressConnect 和 ZENA 均为 Microchip Technology Incorporated 在美国和其他

国家或地区的商标。

SQTP 为 Microchip Technology Incorporated 在美国的服务标记。

Adaptec 徽标、Frequency on Demand、Silicon Storage Technology 和 Symmcom 均为 Microchip Technology Inc.在
除美国外的国家或地区的注册商标。

GestIC 为 Microchip Technology Inc.的子公司 Microchip Technology Germany II GmbH & Co. KG 在除美国外的国家

或地区的注册商标。

在此提及的所有其他商标均为各持有公司所有。

© 2019-2022, Microchip Technology Incorporated 版权所有。
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AMBA、Arm、Arm7、Arm7TDMI、Arm9、Arm11、Artisan、big.LITTLE、Cordio、CoreLink、CoreSight、Cortex、
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质量管理体系

有关 Microchip 的质量管理体系的信息，请访问 www.microchip.com/quality。
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